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* เอกสารนี้ใช้ GT Designer3 (GOT2000) Version1.153Kในการอธิบาย
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คุณลักษณะของ GOT.    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1

รูปลักษณ์ภายนอกของ GOT และอินเตอร์เฟซส่วนขยาย .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 2

การเตรียมอุปกรณ์ที่จ�าเป็น  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 3

อุปกรณ์ที่จ�าเป็นส�าหรับการปฏิบัติการกับ GOT     .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 3

คุณลักษณะของ GT Designer3 .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 4

การจัดวางหน้าจอของ GT Designer3 .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 5

หน้าจอที่สามารถสร้างด้วย GT Designer3   .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 6

ขั้นตอนที่ 1 การสร้าง PROJECT 1-1

1.1 การสร้าง PROJECT ใหม่ .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   1-2

1.2 กาสร้างวัตถ ุ .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   1-9

1.2.1 การสร้าง RUN switch   .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   1-9

1.2.2 การสร้าง STOP switch  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-13

1.2.3 การสร้างหลอดไฟ Running.    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-16

1.2.4 การสร้างหน้าจอแสดงตัวเลข   .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-21

1.3 การสร้างภาพ     .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-23

1.3.1 การสร้างภาพ (สี่เหลี่ยม).    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-23

1.3.2 การสร้างภาพ (ข้อความ) 1 ถึง 3    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-25

1.3.3 การสร้างภาพ (ข้อความ) 4 และ 5 .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-28

1.4 การตั้งค่าฟังก์ชันท่าทางหน้าจอ  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-29

1.5 การตรวจสอบหน้าจอที่สร้างขึ้น .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-33

1.5.1 การตรวจสอบการแสดงผล (การดูตัวอย่างบนหน้าจอ)    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-33

1.5.2 การตรวจสอบข้อผิดพลาดข้อมูล (การตรวจสอบข้อมูล) .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-36

1.5.3 การตรวจสอบการปฏิบัติการ (Simulation)  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-37

1.6 การบันทึก PROJECT  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 1-41

ขั้นตอนที่ 2 การถ่ายโอนข้อมูล PROJECT 2-1

2.1 การถ่ายโอนข้อมูล PROJECT     .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   2-2

2.1.1 การเชื่อมต่อคอมพิวเตอร์ส่วนบุคคลกับ GOT  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   2-2

2.1.2 การตั้งค่าการสื่อสาร  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   2-3

2.1.3 การถ่ายโอนข้อมูล project   .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   2-4

2.2 การเชื่อมต่อ GOT และ PLC  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   2-6

2.2.1 การเชื่อมต่อ GOT และ PLC     .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   2-6

2.2.2 การตรวจสอบสถานะการเชื่อมต่อ     .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   2-7

2.2.3 การเขียนโปรแกรมแลดเดอร์ไปยัง PLC  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   2-9

เนื้อหา



1

2

3

4

ภาคผน
วก

ขั้นตอนที่ 3 การใช้งาน GOT 3-1

3.1 การตรวจสอบแอคชัน ON/OFF ของ switch  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   3-2

3.2 การใช้งานฟังก์ชันท่าทางหน้าจอ     .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   3-4

3.3 รายการของฟังก์ชันต่างๆ ของ GOT     .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   3-6

3.4 ฟังก์ชันส�าหรับการบ�ารุงรักษา    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 3-10

ขั้นตอนที่ 4 การบ�ารุงรักษา GOT 4-1

4.1 ความจ�าเป็นในการบ�ารุงรักษา     .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   4-2

4.2 ส�ารองข้อมูล .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   4-3

4.2.1 การส�ารองข้อมูล GOT   .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   4-5

4.2.2 การส�ารองข้อมูลอุปกรณ์ที่ท�าการเชื่อมต่อ   .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 4-10

4.3 แจ้งเตือน .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 4-18

4.3.1 การตรวจสอบระบบการแจ้งเตือน.    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 4-19

4.4 แบตเตอรี่ .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 4-21

4.4.1 การติดตั้งแบตเตอรี่   .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 4-21

4.4.2 การถอดแบตเตอรี่.    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 4-25

4.4.3 การตรวจสอบแรงดันไฟฟ้าแบตเตอรี่ .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . 4-28

ภาคผนวก ภาคผนวก 1-1

ภาคผนวก 1 รหัสผิดพลาดและรายการแจ้งเตือนของระบบ.    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . ภาคผนวก 1-1

ภาคผนวก 2 การติดตั้งและการถอดประกอบ  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . ภาคผนวก 2-1

1 ข้อควรระวังเบื้องต้น  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . ภาคผนวก 2-1

2 ขนาด panel .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . ภาคผนวก 2-1

3 ต�าแหน่งการติดตั้ง .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . ภาคผนวก 2-3

4 อุณหภูมิภายในแผงควบคุมและมุมการติดตั้งของ GOT    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . ภาคผนวก 2-6

5 การติดตั้ง GOT.    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . ภาคผนวก 2-7

6 การถอด GOT  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . ภาคผนวก 2-8

7 การใส่/การถอดเอสดีการ์ด   .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . ภาคผนวก 2-9

8 การจัดเรียงสายไฟจ่ายไฟไปยัง GOT   .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .   ภาคผนวก 2-11

ภาคผนวก 3 การ calibrate แผงสัมผัส   .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . ภาคผนวก 3-1

ภาคผนวก 4 แคทตาล็อกและคู่มือที่เกี่ยวข้อง  .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . ภาคผนวก 4-1

ภาคผนวก 5 ชุดประกอบอุปกรณ์ฝึกอบรมการปฏิบัติ    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    .    . ภาคผนวก 5-1



1

GOT เป็นค�าย่อของ “Graphic Operation Terminal”

และหลอดไฟเป็นฮาร์ดแวร์ที่ติดกับหน้าจอสัมผัส ซึ่งการใช้ซอฟต์แวร์ที่ใช้ในการออกแบบหน้าจอสามารถสร้างแสดงผลและปฏิบัติงานผ่านแผงสัมผัสบนหน้า

จอ GOT ได้

ประหยดั
พื�นที�

GOT

การลด
ต้นทุน

แผงควบคุม
แบบดั�งเดมิ

ข้อดีของ GOT

(1) การลดขนาดหน้าจอสัมผัส
เนื่องจาก switch และหลอดไฟถูกสร้างด้วยซอฟต์แวร์ จ�านวนของฮาร์ดแวร์ที่ติดอยู่บนหน้าจอสัมผัสจะลดลง และแผงควบคุมการปฏิบัติการเองก็จะ

สามารถลดขนาดลงได้ด้วย

(2) การลดค่าใช้จ่ายในการจัดเรียงสายไฟ
การจัดเรียงสายไฟระหว่างส่วนประกอบต่างๆ ภายในแผงปฏิบัติการถูกแทนที่ด้วยการออกแบบหน้าจอด้วยซอฟต์แวร์ การลดความจ�าเป็นในการจัดเรียง

สายไฟ ซึ่งต้องการเวลาและค่าใช้จ่ายจ�านวนมาก

(3) หน้าจอสัมผัสรมาตรฐาน
แม้ว่าคุณลักษณะที่ต้องการจะเปลี่ยนไป คุณเพียงเปลี่ยนการตั้งค่าโดยใช้ซอฟต์แวร์

ดังนั้นจึงสามารถท�าหน้าจอสัมผัสให้เป็นมาตรฐานได้

(4) การเพิ่มค่าพิเศษเป็น HMI (Human Machine Interface)
GOT สามารถแสดงกราฟิค ข้อความ และการแจ้งเตือนได้อย่างง่ายดาย นอกจาก switch และหลอดไฟ

ดังนั้นจึงสามารถปรับปรุงค่าพิเศษของอุปกรณ์ทั้งหมดของคุณได้

คุณลักษณะของ GOT
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รูปลักษณ์ภายนอกของ GOT และอินเตอร์เฟซส่วนขยาย

ต่อไปนี้จะแสดงรูปลักษณ์ภายนอกของ GOT2000 และอินเตอร์เฟซส่วนขยาย

[ด้านหน้า]

 

* * GT27 (15 นิ�ว และ 12.1 นิ�ว เท่านั�น)

GOT ตรวจพบผูป้ฏิบติังานและ
การแสดงผลของหนา้จอโดยอตัโนมติั 
หากไม่มีผูใ้ดอยูใ่นบริเวณ 
ปิดไฟพื�นหลงัเพื�อ
ประหยดัพลงังาน

การออกแบบที�มีสไตลแ์ละง่ายดว้ย
ลกัษณะเสน้ตรงมีความทนัสมยัและ
เสริมการออกแบบเครื�องจกัรใดๆ

สามารถถ่ายโอนขอ้มูลโดยไม่ตอ้ง
เปิดตู้

วงรอบอายกุารใชง้านที�ยาวนานจะลด
ตน้ทุนในการบาํรุงรักษาและการเปลี�ยน 

สามารถถ่ายโอนขอ้มูลหนา้จอ 
และสามารถรับขอ้มูลใน GOT 
โดยใชห้น่วยความจาํ USB 
สามารถเชื�อมต่อเมา้ส์ USB และ คียบ์อร์ด USB ได้

เซ็นเซอร์มนุษย์ การออกแบบอย่างง่าย

ไฟแบคไลท์ LED

อุปกรณ์ USB

โฮสต์ USB

* อุปกรณ์ USB อยูที่�ดา้นหลงัสาํหรับรุ่นสีขาวและ GT21

* GT27 และ GT25 เท่านั�น โฮสต ์USB 
อยูที่�ดา้นหลงัสาํหรับรุ่นสีขาว

[ด้านหลัง]

อนิเตอร์เฟซส่วนต่อขยาย

Ethernet

RS-422/485

ช่องใส่เอสดกีาร์ด

สามารถติดยนิูตสื�อสาร
และยนิูตตวัเลือก

สามารถเชื�อมต่ออุปกรณ์ FA ที�หลากหลาย 
เครื�องอ่านบาร์โคด้ เครื�องพิมพร์หสัได้

สามารถบนัทึก
ขอ้มูลจาํนวนมากรวมถึง
การแจง้เตือนและขอ้มูลที�บนัทึก

สามารถเชื�อมต่ออุปกรณ์ FA 
ที�หลากหลาย

สามารถเชื�อมต่อ PLC 
ไดถึ้งสี�ชนิดจาก 
ผูผ้ลิตที�แตกต่างกนั* พร้อมกนั
ดว้ย Ethernet 

โฮสต์ USB

สามารถติดตั�งหน่วยความจาํ USB 
เพื�อบนัทึกการแจง้เตือนและ 
ขอ้มูลที�บนัทึก 
สามารถเชื�อมต่อเมา้ส์ USB และ 
คียบ์อร์ด USB ได้

RS-232

* GT27 และ GT25 เท่านั�น

* ภาพนี� คือ GT2712 * GT27 และ GT25 เท่านั�น

อุปกรณ์ USB

สามารถเชื�อมต่อ GOT 
กบัคอมพิวเตอร์ส่วนบุคคล 
เพื�อถ่ายโอนขอ้มูล
* รุ่นสีขาวเท่านั�น

* PLC ถึงสองชนิดสาํหรับ GT21
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การเตรียมอุปกรณ์ที่จ�าเป็น

อุปกรณ์ที่จ�าเป็นส�าหรับการปฏิบัติการกับ GOT

หากต้องการปฏิบัติการกับ GOT จ�าเป็นต้องมี GOT ( 1 ) สายเคเบิล ( 2 ) คอมพิวเตอร์ส่วนบุคคลและซอฟต์แวร์ ( 3 ) และตัวควบคุม ( 4 )

GOT2000 (GT27)

สาย USB 
(GT09-C30USB-5P)

สาย Ethernet

PLC 

GOT สายเคเบิล คอมพิวเตอร์ส่วนบุคคลและซอฟตแ์วร์

PLC

2 3

4

คอมพิวเตอร์ส่วนบุคคล

GT Designer3 (GOT2000) 
ช่วยเหลือ GT Designer3 (GOT2000)

GX Works3

1

การอ้างอิง

ส�าหรับวิธีการติดตั้งซอฟต์แวร์ที่ใช้ในการออกแบบหน้าจอ โปรดดูเอกสารต่อไปนี้

 ● GT Works3 Installation Instructions BCN-P5999-0066/0071

ส�าหรับวิธีการเชื่อมต่อของ GOT และตัวควบคุม โปรดดูเอกสารต่อไปนี้

 ● GOT2000 Series Connection Manual (Mitsubishi Products) For GT Works3 Version1 SH-081197ENG
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GT Designer3 เป็นซอฟต์แวร์ที่ใช้ในการสร้างหน้าจอส�าหรับซีรี่ส์ GOT2000 และซีรี่ส์ GOT1000

ซอฟต์แวร์นี้เปิดให้คุณสร้างและสร้าง project และถ่ายโอนข้อมูลระหว่าง GOT และคอมพิวเตอร์ส่วนบุคคล

การจาํลอง

การสร้าง Project

คอมพิวเตอร์ส่วนบุคคล (GT Designer3)

การถ่ายโอนขอ้มูล

GOT

GT Designer3 ประกอบด้วยซอฟต์แวร์ที่ใช้ในการออกแบบหน้าจอจอต่อไปนี้

 ● GT Designer3 (GOT2000): ซอฟต์แวร์ที่ใช้ในการออกแบบหน้าจอส�าหรับซีรี่ส์ GOT2000

 ● GT Designer3 (GOT1000): ซอฟต์แวร์ที่ใช้ในการออกแบบหน้าจอส�าหรับซีรี่ส์ GOT1000

เอกสารนี้บรรยายการสร้างหน้าจอส�าหรับ GOT2000 ด้วย GT Designer3 (GOT2000)

ภาพหน้าจอของ GT Designer3 (GOT2000)

คุณลักษณะของ GT Designer3
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การจัดวางหน้าจอของ GT Designer3

ต่อไปนี้จะแสดงการจัดวางหน้าจอของ GT Designer3

1

2

3

4

5

6

7

8
3

4

3

1  Title bar

แสดงชื่อซอฟต์แวร์ ชื่อ project และชื่อไฟล์

2  Menu bar

GT Designer3 สามารถท�างานได้จากเมนูแบบดึงลง

3  Toolbar

GT Designer3 สามารถท�างานได้ด้วยปุ่ม คุณสามารถวาง Toolbar ที่ด้านซ้าย ขวา บน หรือล่าง

4  Docking window

หน้าต่างที่สามารถเชื่อมต่อกับหน้าจอของ GT Designer3

5  Editor tab

แสดงแท็บของหน้าต่างและตัวแก้ไขหน้าจอที่แสดงบน work window

6  Work window

ตัวแก้ไขหน้าจอ หน้าต่าง [Environmental Setting] หน้าต่าง [GOT Setup] และหน้าต่างอื่นๆ

7  Screen editor (ตัวแก้ไขหน้าจอ)

สร้างหน้าจอเพื่อแสดงบน GOT โดยการวางภาพและวัตถุบนตัวแก้ไขหน้าจอ

8  Status bar

ข้อมูลที่แสดงตามต�าแหน่งของเคอร์เซอร์เม้าส์ สถานะของภาพหรือวัตถุที่เลือกไว้
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(a) หนา้ต่างที�ซอ้นกนั

(c) หนา้ต่างกญุแจ

(d) หนา้ต่างขอ้ความ

(b) หนา้ต่างที�เหลื�อมกนั

หนา้จอที�สร้างดว้ย GT Designer3 หนา้จอที�แสดงบน GOT

348BA1254

หนา้จอสถานะการผลิต 1

หนา้จอพื�นฐาน

348BA 1254

หนา้จอสถานะการผลิต 1

หนา้จอพื�นฐาน

หนา้จอหนา้ต่าง

หนา้จอ 1

(1) หน้าจอพื้นฐาน
หน้าจอพื้นฐานของ GOT

(2) หน้าจอหน้าต่าง
หน้าจอจะแสดงผลเป็น superimpose window key window และ dialog window บน GOT

(a) superimpose window

หน้าต่างซ้อนกันบนหน้าจอพื้นฐานและแสดงผลเป็นส่วนหนึ่งของหน้าจอพื้นฐาน

สามารถแสดงผลได้ถึงสอง superimpose window พร้อมกัน

(b) overlap window

หน้าต่างป๊อบอัพแสดงผลเหนือหน้าจอพื้นฐาน

สามารถแสดงผลได้ถึงห้า overlap window พร้อมกัน

สามารถย้ายต�าแหน่งการแสดงผลของ overlap window ด้วยการสัมผัสหรือตั้งค่าต�าแหน่งการแสดงผล

(GT21 สามารถแสดงผลได้ถึงสอง overlap window พร้อมกัน)

(c) key window

หน้าต่างป๊อบอัพแสดงผลบนหน้าจอพื้นฐานส�าหรับการกรอกตัวเลขและอื่นๆ

สามารถย้ายต�าแหน่งการแสดงผลของหน้าต่างกุญแจด้วยการสัมผัส

มี key window สองชนิด: key window มาตรฐาน GOT และ key window ที่สร้างโดยผู้ใช้งาน

(d) dialog window

หน้าต่างแสดงผลข้อความ Error ข้อความ Warning และข้อความระบบ GOT

ในขณะที่ dialog window แสดงผล หน้าต่างอื่นจะไม่สามารถท�างานได้

(3) หน้าจอรายงาน
หน้าต่างส�าหรับการเอาท์พุตข้อมูลโดยฟังก์ชันรายงาน

หน้าจอนี้จะไม่แสดงบน GOT

หน้าจอที่สามารถสร้างด้วย GT Designer3
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บันทึก



1-1

1ขั้นตอนที่ 1 

การสร้าง PROJECT
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หน้าจอต่อไปนี้จะถูกสร้างในส่วนนี้

1 2

6

3

5
4

1 RUN switch STOP switch
แตะแต่ละ switch เพื่อเปิดหรือปิดอุปกรณ์บิตของ PLC

→ 1.2.1 การสร้าง RUN switch

→ 1.2.2 การสร้าง STOP switch

2 หลอดไฟ Running
เปิดหรือปิดตามสถานะของอุปกรณ์บิตของ PLC

→ 1.2.3 การสร้างหลอดไฟ Running

3 แสดงตัวเลข
การแสดงค่าที่บันทึกไว้ใน PLC

→ 1.2.4 การสร้างหน้าจอแสดงตัวเลข

4 ภาพ (สี่เหลี่ยม)
โปรดสร้างกรอบสี่เหลี่ยมเพื่อ switch และมองเห็นหลอดไฟได้ชัดขึ้น

→ 1.3.1 การสร้างภาพ (สี่เหลี่ยม)

5 ภาพ (ข้อความ) 1 ถึง 5
ตัวละครที่บรรยายหน้าจอ switch และหลอดไฟจะถูกแสดง

→ 1.3.2 การสร้างภาพ (ข้อความ) 1 ถึง 3

→ 1.3.3 การสร้างภาพ (ข้อความ) 4 และ 5

6 switch ท่าทางหน้าจอ
หุบเข้าหน้าจอเพื่อย่อหน้าจอและกางออกเพื่อขยายหน้าจอด้วย switch นี้

→ 1.4 การตั้งค่าฟังก์ชันท่าทางหน้าจอ

1.1 การสร้าง PROJECT ใหม่
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1

(1) การสร้าง project ใหม่
เริ่ม GT Designer3(GOT2000) และท�าตามตัวช่วยติดตั้งเพื่อก�าหนดค่าการตั้งค่า

คลิก!

1

1 เลือก [MELSOFT Application] → [GT Works3] → 

[GT Designer3] จากเมนูเริ่มต้นของ Windows

คลิก!

2
2 คลิกปุ่ม [New] ในข้อความ Select Project

คลิก!

3

3 คลิกปุ่ม [Next] บนหน้าจอเริ่มต้นของ New Project Wizard
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Remark

สามารถเริ่ม GT Designer3 จากเดสก์ท็อปเมื่อไอคอนทางลัดถูกสร้างระหว่างการติดตั้ง

คลิก!

4

4 ตรวจสอบการตั้งค่าบน system setting window และคลิกปุ่ม 

[Next]

• Series: GOT2000

• GOT Type: GT27**-V (640×480)

• Use the gesture function: ที่เลือกไว้

• Standard Language: English

• Outline Font

Alphanumeric/Kana: ที่เลือกไว้

Kanji: ถูกล้าง

Hangul: ถูกล้าง

คลิก!

5

5 ตรวจสอบการตั้งค่าที่แสดงและคลิกปุ่ม [Next]

คลิก!

7

เลือก 6

6 เลือก [MELSEC iQ-R, RnMT/NC] ในรายการดรอปดาวน์ของ 

[Controller Type] บน communication settings window

7 คลิกปุ่ม [Next]
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1

คลิก!

9

เลือก 8

8 เลือก [Standard(Ethernet):Multi] ในรายการดรอปดาวน์ของ 

[I/F]

9 คลิกปุ่ม [Next]

คลิก!

10

10 ตรวจสอบการตั้งค่าไดรฟ์เวอร์สื่อสารและคลิกปุ่ม [Detail 

Setting]

Communication Driver: Ethernet(MELSEC), Q17nNC, 

CRnD-700, Gateway

คลิก!

11

คลิก!

12

11 หน้าต่างที่แสดงด้านซ้ายจะปรากฏ เปลี่ยนค่าของ [GOT 

Station]

GOT Station: 2

12 คลิกปุ่ม [OK]

Remark

คลิกปุ่ม [GOT Standard Ethernet Setting] เพื่อเปลี่ยนที่อยู่ไอพีของ GOT
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คลิก!

13

13 คลิกปุ่ม [Next]

คลิก!

14

14 ตรวจสอบการตั้งค่าที่แสดงและคลิกปุ่ม [Next]

คลิก!

15

15 ตรวจสอบ อุปกรณ์เปลี่ยนหน้าจอของหน้าจอพื้นฐานและคลิก

ปุ่ม [Next]

Base Screen: GD100 (Default)
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1

คลิก!

16

16 ตรวจสอบการตั้งค่าด้วยตัวช่วยติดตั้ง จากนั้นคลิกปุ่ม [Finish]

หน้าจอแก้ไขของ GT Designer3(GOT2000) จะปรากฏ และหน้าจอพื้นฐาน 1 จะถูกสร้างขึ้น
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 ■ เมื่อ GT Designer3(GOT1000) เริ่มการท�างาน

GT Designer3 เริ่มซอฟต์แวร์ที่ใช้ในการออกแบบหน้าจอที่ถูกใช้ในการบันทึก project ครั้งล่าสุด

เมื�อเริ�มตน้ซอฟตแ์วร์ออกแบบหนา้จอสาํหรับ GOT1000

เมื่อ GT Designer3(GOT1000) เริ่มการท�างาน เริ่มซอฟต์แวร์ที่ใช้ในการออกแบบหน้าจอส�าหรับ GOT2000 โดยวิธีใดวิธีหนึ่งต่อไปนี้

(1) การเริ่ม GT Designer3(GOT2000) จากเมนู
เลือก [Project] → [Start GT Designer3(GOT2000)] จาก Menu bar เพื่อเริ่มการท�างาน GT Designer3(GOT2000)

(2) การเริ่ม GT Designer3(GOT2000) จากตัวช่วยติดตั้ง
เลือก [GOT2000] ส�าหรับ [Series] บนข้อความ [New Project Wizard] เพื่อเริ่ม GT Designer3(GOT2000)
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1

(1) การวาง switch
เลือก [Object] → [Switch] → [Bit Switch] จาก Menu bar เพื่อวาง switch

Remark

คุณสามารถเลือกรายการจาก Toolbar ได้เช่นกัน

Remark

การวางวัตถุ

เมื่อเลือกวัตถุหนึ่งจากเมนูหรือ Toolbar แล้ว รูปร่างของ เมนูจะเปลี่ยนเป็น “+”

คลิกพื้นที่ใดๆ ที่จะวางวัตถุบนตัวแก้ไขหน้าจอ

คลิก วาง

สามารถวางวัตถุทุกขนาดเมื่อท�าการวางโดยการลากเคอร์เซอร์

ลาก วาง

(2) การตั้งค่าอุปกรณ์และแอคชัน

คลิก
สองครั� ง!

1

1 คลิกสองครั้งที่ switch ที่วาง

1.2 กาสร้างวัตถุ

1.2.1 การสร้าง RUN switch
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ตั�งค่า “Device: M0” และ 
“Action: Momentary”

2

เมื่อข้อความแสดงที่ด้านซ้าย ตั้งค่ารายการต่อไปนี้

2 Device: M0

Action: Momentary

point

การตั้งค่าอุปกรณ์

คลิก  เพื่อตั้งค่าอุปกรณ์

คลิก!

point

สามารถตั้งค่าอุปกรณ์โดยการป้อนโดยตรงโดยใช้คีย์บอร์ด
ป้อนอุปกรณ์ 
โดยตรงและ 
กดปุ่ม Enter
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1

(3) การตั้งค่าข้อความ

คลิก!

3

ป้อน “RUN” 
ใน Text

4

คลิก!

5

3 เลือก Text tab

4 ป้อน “RUN” ใน Text

5 คลิกปุ่ม [OK]

การสร้าง RUN switch สมบูรณ์

การอ้างอิง

หากคุณมีค�าถามใดๆ กดปุ่ม F1 เพื่อเริ่มต้นการช่วยเหลือ GT Designer3(GOT2000) 

หน้าวิธีใช้ที่เหมาะสมส�าหรับการปฏิบัตินั้นๆ ที่คุณก�าลังท�าอยู่จะปรากฎขึ้น
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 ■ ประเภท Bit switch

Bit switch เปิดและปิดอุปกรณ์บิตที่ระบุโดย switch

ต่อไปนี้จะแสดงแอคชันที่สามารถตั้งค่าด้วย Bit switch

(1) บิตชั่วขณะ
เปิดอุปกรณ์บิตที่ระบุค้างไว้ชั่วขณะในขณะที่สัมผัสกับ switch

X0001: OFF

STOP

X0001: OFF

STOP

X0001: ON

RUN

X0001: OFF

STOP

X0001: ON

RUN

(2) บิตทางเลือก
เปลี่ยนสถานะของอุปกรณ์บิตที่ระบุ (ON←→OFF) เมื่อคุณสัมผัสกับ switch
X0001: OFF

STOP

X0001: ON

RUN

X0001: ON

RUN

X0001: ON

RUN

X0001: OFF

STOP

X0001: OFF

STOP

(3) สวิตซ์บิตเซ็ต
เปิดอุปกรณ์บิตที่ระบุเมื่อคุณสัมผัสกับ switch
X0001: OFF

STOP

X0001: ON

RUN

X0001: ON

RUN

X0001: ON

RUN

X0001: ON

RUN

X0001: ON

RUN

(4) สวิตซ์บิตรีเซ็ต
ปิดอุปกรณ์บิตที่ระบุเมื่อคุณสัมผัสกับ switch

X0001: OFF

STOP

X0001: ON

RUN

X0001: OFF

STOP

X0001: OFF

STOP

X0001: OFF

STOP

X0001: OFF

STOP
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1

(1) การคัดลอก RUN switch

ลาก switch 
ในขณะที�กด 
ปุ่ม Ctrl คา้งไว้ 2

คลิก!

1

1 เลือก RUN switch

2 ลาก switch ในขณะที่กด ปุ่ม Ctrl ค้างไว้

(2) การตั้งค่าส�าเนาของ RUN switch

คลิก
สองครั� ง!

3

3 คลิกสองครั้งที่ RUN switch ที่คัดลอก

เปลี�ยนอุปกรณ์ 
จาก “M0” เป็น “M1” 4

4 เมื่อข้อความแสดงที่ด้านซ้ายปรากฏ เปลี่ยนอุปกรณ์ดังต่อไปนี้

Device: M0 → M1

1.2.2 การสร้าง STOP switch
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(3) การเปลี่ยนสีของรูปร่างของ switch

คลิก!

5

คลิก!

6
คลิก!

8

เปลี�ยนสีจาก 
“Blue” เป็น “Red” 7 9

5 เลือก Style tab

6 เลือกรูปร่างของสถานะปิด

7 เลือกสีของรูปร่าง

Blue → Red

8 เลือกรูปร่างของสถานะเปิด

9 เลือกสีของรูปร่าง

Blue → Red

(4) การเปลี่ยนข้อความของ switch

คลิก!

10

เปลี�ยนขอ้ความ 
จาก “RUN” เป็น 
“STOP” 11

คลิก!

12

10 เลือก Text tab

11 ป้อน “STOP” ใน Text

12 คลิกปุ่ม [OK]

การสร้าง STOP switch เสร็จสิ้น
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1

 ■ แผ่นคุณลักษณะ

แผ่นคุณลักษณะแสดงรายการของคุณลักษณะและตั้งค่าของหน้าจอ ภาพ หรือวัตถุที่เลือก

สามารถตรวจสอบหรือเปลี่ยนการตั้งค่าโดยไม่ต้องเปิดข้อความการตั้งค่า

สามารถเปลี่ยนการตั้งค่าเป็นกลุ่มหรือโดยการเลือกหลายภาพหรือหลายวัตถุบนหน้าจอเดียวกัน

การเปลี�ยนอุปกรณ์ การเปลี�ยนสีของรูปร่าง การเปลี�ยนขอ้ความ

การอ้างอิง

ส�าหรับวิธีการแสดง แผ่นคุณลักษณะและวิธีการตั้งค่าแต่ละรายการ โปรดดูการช่วยเหลือหรือ GT Designer3(GOT2000) Screen Design Manual
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(1) การวางหลอด
เลือก [Object] → [Lamp] → [Bit Lamp] จาก Menu bar เพื่อวางหลอด

Remark

คุณสามารถเลือกรายการจาก Toolbar ได้เช่นกัน

(2) การตั้งค่าอุปกรณ์ รูปร่าง และสีส�าหรับหลอดไฟ

คลิก
สองครั� ง!

1

1 คลิกสองครั้งที่หลอดไฟที่วาง

เปลี�ยนสีจาก 
“Red” เป็น “Green” 4 6

คลิก!

3

คลิก!

5

ตั�งค่า “Y0010”

2

เมื่อข้อความแสดงที่ด้านซ้าย ตั้งค่ารายการต่อไปนี้

2 Device: Y0010

3 เลือกรูปร่างของสถานะปิด

4 เลือกสีของรูปร่าง

Red → Green

5 เลือกรูปร่างของสถานะเปิด

6 เลือกสีของรูปร่าง

Red → Green

1.2.3 การสร้างหลอดไฟ Running
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1

(3) ข้อความการตั้งค่าส�าหรับหลอดไฟ

คลิก!

7

เลือก 
“12” 9

ป้อน 
“STOP” 10

คลิก!

8

7 เลือก Text tab

8 เลือกรูปร่างของสถานะปิด

9 Text Size: เลือก 12 จุด

10 ป้อน “STOP” ใน Text

คลิก!

12 เลือก 
“Black” 13

คลิก!

11

ป้อน 
“RUN” 14

คลิก!

15

11 ล้างกล่องกาเครื่องหมายส�าหรับ “OFF=ON”

12 เลือกรูปร่างของสถานะเปิด

13 เลือก Black ส�าหรับ Text Color

14 ป้อน “RUN” ใน Text

15 คลิกปุ่ม [OK]

การสร้างหลอดไฟ Running เสร็จสมบูรณ์
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 ■ การแสดงวัตถุบนตัวแก้ไขหน้าจอ

สถานะของวัตถุที่จะแสดงบน ตัวแก้ไขหน้าจอและสามารถเปลี่ยนการแสดงหรือไม่แสดงข้อมูลที่ตั้งค่าไว้ได้

(1) การเปลี่ยนสถานะของวัตถุที่จะแสดงบนตัวแก้ไขหน้าจอ
(a) การเปลี่ยนสถานะระหว่าง ON และ OFF

เลือก [View] → [Switch ON/OFF Display] จากเมนูเพื่อเปลี่ยนภาพสถานะเปิดและภาพสถานะปิดของแต่ละวัตถุบนตัวแก้ไขหน้าจอ

หากตั้งค่าสถานะบนวัตถุหนึ่ง การแสดงผลของ switch วัตถุระหว่าง OFF ที่มีสถานะหมายเลข 0 และ ON ที่มีสถานะหมายเลข 1

(b) การเปลี่ยนสถานะโดยการระบุหมายเลขสถานะ

เลือก [View] → [State No.] → [Previous State] หรือ [Next State] จากเมนูเพื่อเปลี่ยนการแสดงผลของวัตถุบนตัวแก้ไขหน้าจอตามหมายเลขสถานะ

หากสถานะของวัตถุถูกเปลี่ยนระหว่าง ON และ OFF การแสดงผลของวัตถุระหว่าง OFF ที่มีหมายเลขสถานะ 0 และ ON ที่มีหมายเลขสถานะ 1 

หรือมากกว่า

สถานะหมายเลข 0 สถานะหมายเลข 1 สถานะหมายเลข 63

•••

(2) การตั้งค่าข้อมูลที่จะแสดงบนตัวแก้ไขหน้าจอ
(a) อุปกรณ์

เลือก [View] → [Display Items] → [Device] จากเมนูเพื่อเปลี่ยนการแสดงและการซ่อนอุปกรณ์บนตัวแก้ไขหน้าจอ

(b) อุปกรณ์ฉลากระบบ

เลือก [View] → [Display Items] → [Device of System Label] จากเมนูเพื่อเปลี่ยนการแสดงและการซ่อนฉลากระบบบนตัวแก้ไขหน้าจอ
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1

(c) ID วัตถุ

เลือก [View] → [Display Items] → [Object ID] จากเมนูเพื่อเปลี่ยนการแสดงและการซ่อนวัตถุบนตัวแก้ไขหน้าจอ

(d) ระบายสี

เลือก [View] → [Display Items] → [Paint] จากเมนูเพื่อเปลี่ยนการแสดงและการซ่อนสีบนตัวแก้ไขหน้าจอ

(e) วัตถุ

เลือก [View] → [Display Items] → [Object] จากเมนูเพื่อสลับระหว่างการแสดงและการซ่อนวัตถุบนตัวแก้ไขหน้าจอ

(f) กรอบวัตถุ

เลือก [View] → [Display Items] → [Object Frame] จากเมนูเพื่อเปลี่ยนการแสดงและการซ่อนวัตถุบนตัวแก้ไขหน้าจอ

(g) ข้อมูลเทมเพลต

เลือก [View] → [Display Items] → [Template Information] จากเมนเพื่อเปลี่ยนการแสดงและการซ่อนข้อมูล Template บนตัวแก้ไขหน้าจอ
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(h) Touch Area

เลือก [View] → [Display Items] → [Touch Area] จากเมนูเพื่อเปลี่ยนการแสดงและการซ่อน Touch Area บนตัวแก้ไขหน้าจอ

(i) ตัวเลือก

เลือก [View] → [Display Items] → [Option] จากเมนูเพื่อแสดงข้อความ [Option]

ในข้อความนี้ คุณสามารถก�าหนดค่าการตั้งค่าที่แสดงบนตัวแก้ไขหน้าจอ

การอ้างอิง

ส�าหรับรายละเอียดของตัวเลือก โปรดดูการช่วยเหลือหรือ GT Designer3(GOT2000) Screen Design Manual

 ■ การปฏิบัติงานโดยใช้ Toolbar

การแสดงของวัตถุสามารถเปลี่ยนได้โดยใช้ Toolbar [View] เช่นกัน

ON/OFF การเปลี�ยนการแสดงผล สถานะหมายเลข

อุปกรณ์

อุปกรณ์ฉลากระบบ

ID วตัถุ
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1

(1) การวางหน้าจอแสดงตัวเลข
เลือก [Object] → [Numerical Display/Input] → [Numerical Display] จาก Menu bar เพื่อวางหน้าจอแสดงตัวเลข

Remark

คุณสามารถเลือกรายการจาก Toolbar ได้เช่นกัน

(2) การตั้งค่าอุปกรณ์และขนาดของตัวเลขส�าหรับหน้าจอแสดงตัวเลข

คลิก
สองครั� ง!

1

1 คลิกสองครั้งที่หน้าจอแสดงตัวเลขที่วาง

ตั�งค่า “D10”
2

เลือก 
“36” 3

เมื่อข้อความแสดงที่ด้านซ้าย ตั้งค่ารายการต่อไปนี้

2 Device: D10

3 Number Size: เลือก 36 จุด

1.2.4 การสร้างหน้าจอแสดงตัวเลข
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(3) การตั้งค่ารูปร่างและสีของกรอบส�าหรับหน้าจอแสดงตัวเลข

คลิก!

4

เลือก “Square_3D_Fixed 
Width : Rect_12” 5

4 เลือก Style tab

5 เลือก “Square_3D_Fixed Width : Rect_12” ส�าหรับรูปร่าง

เลือก 
“Gray” 6

7
คลิก!

6 เลือก Gray ส�าหรับ Frame Color

7 คลิกปุ่ม [OK]

การสร้างหน้าจอแสดงตัวเลขสมบูรณ์
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1

(1) การวางสี่เหลี่ยม
เลือก [Figure] → [Rectangle] จาก Menu bar เพื่อวางสี่เหลี่ยม

Remark

คุณสามารถเลือกรายการจาก Toolbar ได้เช่นกัน

จุดเริ�มตน้

จุดสิ�นสุด

คลิก!

1

คลิก
สองครั� ง!

2

1 ลากเมาส์จากจุดเริ่มต้นไปยังจุดปลายในขณะที่ก�าลังคลิกเมาส์

2 คลิกสองครั้งที่สี่เหลี่ยม

(2) การเปลี่ยนและการตั้งค่าสี่เหลี่ยม

คลิก!

4

เลือก 
“Pattern: □ 8”, 
“Shape Color: Gray”, 
“Type: Rounded” 
และ “Radius: 5”

3

เมื่อข้อความแสดงที่ด้านซ้าย ตั้งค่ารายการต่อไปนี้

3 Pattern: □ 8

Shape Color: Gray

Type: Rounded

Radius: 5 dots

4 คลิกปุ่ม [OK]

การสร้างสี่เหลี่ยมเสร็จสมบูรณ์

1.3 การสร้างภาพ

1.3.1 การสร้างภาพ (สี่เหลี่ยม)
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(3) การคัดลอกสี่เหลี่ยมติดต่อกัน

เลือก

5

5 เลือกสี่เหลี่ยมและเลือก [Edit] → [Consecutive Copy] จาก 

Menu bar

ตั�งค่า “30”

7

ตั�งค่า “3”
6

คลิก!

8

เมื่อข้อความแสดงที่ด้านซ้าย ตั้งค่ารายการต่อไปนี้

6 Total count after copy: X 3

7 Interval: X 30

8 คลิกปุ่ม [OK] เพื่อคัดลอกสี่เหลี่ยมติดต่อกัน

Point

ภาพถูกวางบนเลเยอร์ด้านหลังของวัตถุ



1-25

1

(1) การวางภาพ (ข้อความ) 1
เลือก [Figure] → [Text] จาก Menu bar เพื่อวางภาพ (ข้อความ)

Remark

คุณสามารถเลือกรายการจาก Toolbar ได้เช่นกัน

คลิก!

1
1 คลิกเมาส์บนพื้นที่ที่ท�าการป้อนข้อความ

(2) การตั้งค่าภาพ (ข้อความ) 1

ป้อน RUN switch

2

เลือก 
“Black” 3

คลิก!

5

คลิก!

4

เมื่อข้อความแสดงที่ด้านซ้าย ตั้งค่ารายการต่อไปนี้

2 Text: RUN switch

(สามารถแทรกไลน์ฟีดหลังจากข้อความ “switch” โดยการกด

ปุ่ม Enter ปรับขนาดตัวอักษร)

3 Text Color: Black

4 Alignment: Center

5 คลิกปุ่ม [OK]

การสร้างภาพ (ข้อความ) 1 เสร็จสมบูรณ์

1.3.2 การสร้างภาพ (ข้อความ) 1 ถึง 3
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(3) การคัดลอก (ข้อความ) 1 ติดต่อกันเพื่อสร้าง (ข้อความ) 2 และ 3

เลือก

6
6 เลือก (ข้อความ) 1 และเลือก [Edit] → [Consecutive Copy] 

จาก Menu bar

ตั�งค่า “3” 7

ตั�งค่า “85”

8

คลิก!

9

เมื่อข้อความแสดงที่ด้านซ้าย ตั้งค่ารายการต่อไปนี้

7 Total count after copy: X 3

8 Interval: X 85

9 คลิกปุ่ม [OK] เพื่อคัดลอก (ข้อความ) ติดต่อกัน
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1

(4) การแก้ไขข้อความของส�าเนา

คลิก
สองครั� ง!

10

10 คลิกสองครั้งที่คัดลอก (ข้อความ) 2

ป้อน STOP switch

11

คลิก!

12

เมื่อข้อความแสดงที่ด้านซ้าย ตั้งค่ารายการต่อไปนี้

11 Text: STOP switch

(สามารถ Insert จากข้อความ “switch” โดยการกดปุ่ม Enter)

12 คลิกปุ่ม [OK]

แก้ไขภาพ (ข้อความ) 3 ด้วยกระบวนการเดียวกัน

Text: ไฟ Running

(สามารถ Insert จากข้อความ “ไฟ” โดยการกดปุ่ม Enter)

การสร้างภาพ (ข้อความ) 2 และ 3 สมบูรณ์
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(1) การวางภาพ (ข้อความ) 4
เลือก [Figure] → [Text] จาก Menu bar เพื่อวางภาพ (ข้อความ)

คุณสามารถเลือกภาพ (ข้อความ) จาก Toolbar ได้เช่นกัน

คลิก!

1
1 คลิกเมาส์บนพื้นที่ที่ท�าการป้อนข้อความ

(2) การตั้งค่าภาพ (ข้อความ) 4

ป้อน “แผงควบคุม
การปฏิบติัการ” 2

เลือก “Outline 
Kaisho” 3

เลือก “36”

4

คลิก!

5

เมื่อข้อความแสดงที่ด้านซ้าย ตั้งค่ารายการต่อไปนี้

2 Text: แผงควบคุมการปฏิบัติการ

3 Font: Outline Kaisho

4 Size: 36 dots

5 คลิกปุ่ม [OK]

การสร้างภาพ (ข้อความ) 4 สมบูรณ์

(3) การวางและการตั้งค่าภาพ (ข้อความ) 5 ด้วยกระบวนการเดียวกัน

ตั้งค่ารายการต่อไปนี้

Text: Data 1

Font: Outline Gothic

Size: 16 dots

การสร้างภาพ (ข้อความ) 5 สมบูรณ์

1.3.3 การสร้างภาพ (ข้อความ) 4 และ 5
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1

(1) ฟังก์ชันท่าทางหน้าจอ
ฟังก์ชันนี้เปิดให้สามารถย่อ/ขยายและเลื่อนหน้าจอมอนิเตอร์ของ GOT

เนื้อหาที่แสดงของวัตถุสามารถเลื่อนหน้าจอหรือขยายและย่อโดยสัมผัสกับหน้าจอ GOT โดยตรงโดยใช้ท่าทาง เช่น การหุบออกและหุบเข้า

(ตวัอยา่ง) ถ่างหนา้จอออกเพื�อขยายเนื�อหาที�แสดง

(ตวัอยา่ง) หุบเขา้หนา้จอเพื�อยอ่เนื�อหาที�แสดง

Point

ฟังก์ชันท่าทางหน้าจอถูกเปิดใช้งานเป็นค่าเริ่มต้น

หากฟังก์ชันท่าทางหน้าจอเป็นค่าเริ่มต้น ก�าหนดค่าการตั้งค่าตามกระบวนการต่อไปนี้

เลือก [Common] → [GOT Type Setting] จาก Menu bar เพื่อแสดงข้อความ Type Setting

เลือก [Use the gesture function] และคลิกปุ่ม [OK]

ฟังก์ชันท่าทางหน้าจอถูกเปิดใช้งาน

คลิก!

1.4 การตั้งค่าฟังก์ชันท่าทางหน้าจอ
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(2) การสร้างวัตถุส�าหรับท่าทางหน้าจอ
วาง switch ส�าหรับการเปลี่ยนไปยังโหมดท่าทางหน้าจอ

คลิก!

1

1 เลือก [View] → [Docking Window] → [Library List] จาก 

Menu bar

คลิก!

2

2 คลิกไอคอน  บนหน้าต่าง [Library List]

คลิก!

3

3 เลือก [System Library] → [Search By Function] → [Gesture] 

จากเมนูแบบดึงลงที่แสดง
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1คลิก
สองครั� ง!

4

4 คลิกสองครั้งที่ [Gesture_Title(VGA)]

คลิก!

5

5 รูปแบบที่ลงทะเบียนจะแสดงในรายการ คลิก [1 Gesture01_B]

คลิก!

6

6 ย้ายเคอร์เซอร์ไปยังตัวแก้ไขหน้าจอ และคลิกที่บนซ้ายของ

หน้าจอ

(บรรทัดที่แยกซึ่งแสดงขนาดของวัตถุจะปรากฏ)

วัตถุส�าหรับท่าทางหน้าจอจะถูกวาง

Point

ฟังก์ชันของวัตถุส�าหรับท่าทางหน้าจอ

 ● การเปลี่ยนไปยังโหมดท่าทางหน้าจอ
สมัผสัเพื�อเปลี�ยน
ไปยงัโหมด

การสัมผัสไอคอนต่อไปนี้จะเปลี่ยนไปยังโหมดท่าทางหน้าจอ

 ● การยกเลิกโหมดท่าทางหน้าจอ
สมัผสัเพื�อยกเลิก 
โหมด

การสัมผัสไอคอนต่อไปนี้ระหว่างโหมดท่าทางหน้าจอจะยกเลิกโหมดท่าทางหน้าจอ

 ● การแสดงเต็มหน้าจอ (100%) สมัผสัเพื�อเปลี�ยน 
การแสดงผลเป็น 
การแสดงผลเตม็หนา้จอ

การสัมผัสไอคอนต่อไปนี้จะปรับขนาดหน้าจอให้ใหญ่ขึ้นโดยใช้ ฟังก์ชันท่าทางให้เป็น

ขนาดที่แท้จริง (100%)
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(3) การแสดงผลพื้นที่ที่ท่าทางหน้าจอไม่ท�างาน
“พื้นที่ที่ท่าทางหน้าจอไม่ท�างาน” พื้นที่ขนาด 16 ถึง 100 จุดจากด้านบนหรือด้านล่างของหน้าจอไม่ใช่เป้าหมายส�าหรับการขยายและย่อและเลื่อนหน้าจอ

ระหว่างการใช้ฟังก์ชันท่าทาง

คลิก!

7

7 เลือก [Screen] → [Screen Property] จาก Menu bar

คลิก!

9

การเครื�องหมาย 8

8 เลือก [Display the screen gesture inactive area]

9 คลิกปุ่ม [OK]

การตั้งค่าฟังก์ชันท่าทางหน้าจอเสร็จสมบูรณ์
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1

(1) การตรวจสอบสถานะการแสดงผลว่าเปิดและปิดของหน้าจอและวัตถุที่สร้าง
เลือก [View] → [Preview] จาก Menu bar

คลิก!

1

1 หน้าต่างดูตัวอย่างหน้าจอปรากฏ คลิกปุ่ม [ON]

รูปร่างของ 
สถานะจะ 
แสดง 2

คลิก!

3
2 รูปร่างของวัตถุถูกเปลี่ยนไปเป็นรูปร่างสถานะเปิด

3 การคลิกที่ปุ่ม [OFF] จะแสดงรูปร่างของสถานะปิด

1.5 การตรวจสอบหน้าจอที่สร้างขึ้น

1.5.1 การตรวจสอบการแสดงผล (การดูตัวอย่างบนหน้าจอ)
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 ■ การตรวจสอบการแสดงผลของหลอดไฟและ switch ของแต่ละวัตถุ

บนหน้าต่างดูตัวอย่างหน้าจอการแสดงผลหลอดไฟและ switch สามารถเปลี่ยนเป็นการตรวจสอบแต่ละการแสดงผล

(1) การเปลี่ยนสถานะ ON/OFF

คลิกขวา!

1

คลิก!

2

1 คลิกขวาที่วัตถุ

2 เลือก [ON] หรือ [OFF]

รูปร่างของสถานะเปิด รูปร่างของสถานะปิด

รูปร่างของสถานะเปิด หรือสถานะปิด
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1

(2) การเปลี่ยนค่าการแสดงตัวอย่างของตัวเลขหรืออินพุตตัวเลข

คลิก!

2

คลิกขวา!

1

1 คลิกขวาที่หน้าจอแสดงตัวเลข

2 เลือก [Change Preview Value]

คลิก!

4

ป้อน 
ค่า 3

3 ป้อนค่า

4 คลิกปุ่ม [OK]

ค่าการดูตัวอย่างถูกเปลี่ยน



1-36

(1) การตรวจสอบว่าไม่มีข้อผิดพลาดใน project
เลือก [Tool] → [Data Check] → [Check] จาก Menu bar

การแสดงผล 
ความสมบูรณ์ 1

1 ตรวจสอบว่าข้อความ [Data Check is completed.] แสดงบน

หน้าต่าง Data Check List และไม่มีข้อผิดพลาดใดๆ

คลิก
สองครั� ง!

2

2 หากมีข้อผิดพลาด คลิกสองครั้งที่ผลลัพธ์เพื่อกระโดดไปยัง

ต�าแหน่งที่ท�าให้เกิดข้อผิดพลาดหรือการเตือน

ตรวจสอบข้อผิดพลาดและเปลี่ยนการตั้งค่า

Remark

สามารถตั้งค่ารายการที่จะตรวจสอบกับการตรวจสอบข้อมูล

เลือก [Tool] → [Data Check] → [Item Setting] จาก Menu bar

เลือกรายการ 
ตรวจสอบ

1.5.2 การตรวจสอบข้อผิดพลาดข้อมูล (การตรวจสอบข้อมูล)
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1

(1) การเตรียมโปรแกรมแลดเดอร์
เตรียมโปรแกรมแลดเดอร์ส�าหรับการจ�าลองเหตุการณ์โดยใช้ Simulation

หากต้องการด�าเนินต่อไปยังขั้นตอนถัดไป สร้างโปรแกรมแลดเดอร์โดยใช้ GX Works3

<โปรแกรมตัวอย่าง>

(2) การเริ่มการท�างานของ Simulation ส�าหรับ PLC
เริ่มการท�างาน GX Simulator3 จาก GX Works3

คลิก!

1

1 เลือก [Debug] → [Simulation] → [Start Simulation] จาก 

Menu bar ของ GX Works3

GX Simulator3 เริ่มต้น

1.5.3 การตรวจสอบการปฏิบัติการ (Simulation)
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(3) การเริ่มการท�างานของ Simulation ส�าหรับ GOT เพื่อตรวจสอบหน้าจอที่สร้างขึ้น
เริ่มการท�างาน GT Simulator3 จาก GT Designer3(GOT2000) เพื่อตรวจสอบหน้าจอที่สร้างขึ้น

คลิก!

2

2 เลือก [Tools] → [Simulator] → [Set] จากแถบเมนูของ GT 

Designer3(GOT2000)

เลือก 
“GX Simulator3” 3

คลิก!

4

3 เมื่อข้อความที่แสดงด้านซ้ายปรากฏ เลือก GX Simulator3 

ส�าหรับ Connection

4 คลิกปุ่ม [OK] เพื่อท�าการตั้งค่าให้สมบูรณ์

คลิก!

5

5 เลือก [Tools] → [Simulator] → [Activate] จาก Menu bar ของ 

GT Designer3(GOT2000)
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1

Simulation เริ่มการท�างาน และสามารถจ�าลองหน้าจอที่สร้างได้

ไฟเปิด 
และค่า 
เปลี�ยนเป็น 6666 7

คลิก!

6

6 คลิกปุ่ม RUN

7 ไฟ Running เปิด และค่าของ Data 1 เปลี่ยนเป็น 6666

Remark

Simulation สามารถเริ่มการท�างาน อัพเดต และออกจากการท�างานจาก Toolbar ของ 

GT Designer3(GOT2000)

(1) (2) (3) (4)

(1) [Simulator: Activate]  เปิดใช้งาน GT Simulator3 เพิ่มเริ่มต้นการจ�าลองเหตุการณ์

(2) [Simulator: Update]   อัพเดต project ในการจ�าลองเหตุการณ์ด้วย project ที่จะแก้ไข 
การเปลี่ยนแปลงที่ท�าโดยใช้ GT Designer3(GOT2000) สามารถสะท้อนไปยัง project ในการจ�าลองเหตุการณ์

(3) [Simulator: Set]  เปิดหน้าต่างการตั้งค่าของซิมูเลเตอร์

(4) [Simulator: End]  ออกจาก GT Simulator3
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ไฟปิด 
และค่า 
เปลี�ยนเป็น 3333 9

คลิก!

8

8 คลิกปุ่ม STOP

9 ไฟ Running ปิด และค่าของ Data 1 เปลี่ยนเป็น 3333

(4) การออกจาก Simulation ส�าหรับ GOT
ออกจาก GT Simulator3 หลังจากการจ�าลองเหตุการณ์

คลิก!

10

10 เลือก [Tools] → [Simulator] → [Exit] จาก Menu bar ของ GT 

Designer3(GOT2000)

(5) การออกจาก Simulation ส�าหรับ PLC
ออกจาก GX Simulator3 ของ GX Works3

คลิก!

11

11 เลือก [Debug] → [Simulation] → [Stop Simulation] จาก 

Menu bar ของ GX Works3
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1

(1) การบันทึกหน้าจอที่สร้าง

คลิก!

1

1 เลือก [Project] → [Save As] จาก Menu bar

ป้อนชื�อไฟลแ์ละ 
คลิกปุ่ม Save

2

2 ป้อนชื่อไฟล์และคลิกปุ่ม [Save] เพื่อบันทึกหน้าจอ

(2) ชนิดของไฟล์
สามารถบันทึก project ในรูปแบบต่อไปนี้

• รูปแบบ Workspace

• รูปแบบไฟล์เดียว (*.GTX)

• รูปแบบไฟล์เดียว (*.GTXS) พร้อมกับแอปพลิเคชันของระบบ

การอ้างอิง

เอกสารนี้จะอธิบาย project รูปแบบไฟล์เดียว (*.GTX)

ส�าหรับรายละเอียดของแต่ละรูปแบบ โปรดดูการช่วยเหลือหรือ GT Designer3(GOT2000) Screen Design Manual

1.6 การบันทึก PROJECT
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บันทึก
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2

ขั้นตอนที่ 2 

การถ่ายโอนข้อมูล PROJECT
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ใช้สาย USB ในการเชื่อมต่อคอมพิวเตอร์ส่วนบุคคลกับ GOT

เชื�อมต่อไปยงั 

อินเตอร์เฟซ USB

คอมพิวเตอร์ส่วนบุคคล

GOT

เปิดฝาปิดและ 

เชื�อมต่อสายเคเบิลกบั 

อินเตอร์เฟซ USB

สาย USB 

(GT09-C30USB-5P)

* ส�าหรับการสื่อสาร USB กับ GOT ติดตั้ง USB ไดรฟ์เวอร์

USB ไดรฟ์เวอร์จะถูกติดตั้งบนคอมพิวเตอร์ส่วนบุคคลขณะที่ท�าการเชื่อมต่อครั้งแรก

สามารถถ่ายโอนข้อมูลโดยใช้เอสดีการ์ดหรือวิธีการเชื่อมต่ออื่นนอกจากสาย USB

การอ้างอิง

ส�าหรับวิธีการถ่ายโอนข้อมูลโดยใช้เอสดีการ์ดหรือวิธีการเชื่อมต่ออื่นที่ไม่ใช่สาย USB โปรดดูการ ช่วยเหลือหรือGT Designer3(GOT2000) Screen Design 

Manual

2.1 การถ่ายโอนข้อมูล PROJECT

2.1.1 การเชื่อมต่อคอมพิวเตอร์ส่วนบุคคลกับ GOT
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2

ก�าหนดค่าการตั้งค่าการสื่อสารของคอมพิวเตอร์ส่วนบุคคลและ GOT

เปิด GOT ก่อนท�าการก�าหนดค่า

คลิก!

1
1 เลือก [Communication] → [Write to GOT] จาก Menu bar

คลิก!

3

ตรวจสอบวา่ “Connection to 
GOT: Direct” และ “PC side I/F: 
USB” ถูกเลือก 2

2 ตรวจสอบว่าการตั้งค่าต่อไปนี้

ถูกก�าหนดค่า

Connection to GOT: Direct 

PC side I/F: USB

ท�าการทดสอบการสื่อสารเพื่อตรวจสอบการสื่อสาร

3 คลิกปุ่ม [Test]

คลิก!

4

4 เมื่อข้อความ [Successfully connected.] ปรากฏ คลิกปุ่ม [OK]

คลิก!

5

5 คลิกปุ่ม [OK]

2.1.2 การตั้งค่าการสื่อสาร
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ถ่ายโอนข้อมูล project จากคอมพิวเตอร์ส่วนบุคคลไปยัง GOT

ตรวจสอบ “Write Data: Package Data” 
และ “Destination Drive: C:Built-in 
Flash Memory” 6

คลิก!

7

6 ตรวจสอบว่าการตั้งค่าต่อไปนี้

ถูกก�าหนดค่า

Write Data: Package Data

Destination Drive: C:Built-in Flash Memory

7 คลิกปุ่ม [GOT Write]

คลิก!

8

กล่องข้อความส�าหรับการยืนยันการเขียนไปยัง GOT ปรากฏ

8 คลิกปุ่ม [Yes] เพื่อเริ่มต้นการเขียน

กล่องข้อความที่แสดงที่ด้านซ้ายจะแสดงผลในขณะที่ท�าการเขียน

ข้อมูล

ห้ามด�าเนินการต่อไปนี้

• ปิด GOT

• ถอดสายเคเบิลออก

• เปิดฝาปิดเอสดีการ์ด

คลิก!

9

9 เมื่อท�าการเขียน GOT สมบูรณ์แล้ว กล่องข้อความที่แสดงที่

ด้านซ้ายจะปรากฏ คลิกปุ่ม [OK]

2.1.3 การถ่ายโอนข้อมูล project
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2

GOT จะเริ่มการท�างานใหม่โดยอัตโนมัติ

10 หน้าจอเลือกภาษาจะปรากฏ เลือก [English]
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เชื่อมต่อ GOT และ PLC

ก่อนการเชื่อมต่อ GOT และ PLC ตรวจสอบว่าปิดการท�างานของ GOT และ PLC แล้ว

หลังจากนั้น เชื่อมต่อ GOT และ PLC โดยใช้สาย Ethernet และเปิด GOT และ PLC

เชื�อมต่อไปยงัอินเตอร์เฟซ Ethernet ที�ดา้นหลงั

GOT

PLC

เชื�อมต่อไปยงัอินเตอร์เฟซ Ethernet 

ที�ดา้นหนา้

2.2 การเชื่อมต่อ GOT และ PLC

2.2.1 การเชื่อมต่อ GOT และ PLC
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ท�าการตรวจสอบสถานะ Ethernet ของ GOT เพื่อตรวจสอบว่า GOT สามารถสื่อสารกับ PLC

ฟังก์ชันตรวจสอบสถานะ Ethernet จะตรวจสอบสถานะการเชื่อมต่อระหว่าง GOT และอุปกรณ์บนเครือข่าย Ethernet โดยการส่งการร้องขอปิง

ก่อนท�าการตรวจสอบสถานะ Ethernet ตรวจสอบว่าเปิด GOT และ PLC

1

1 สัมผัสที่ปุ่มเรียก utility บน GOT เพื่อแสดงเมนูหลักของ 

utility

ปุ่มเรียก utility ถูกตั้งค่าเป็นมุมซ้ายบนของหน้าจอ GOT (กด

ปุ่มนาน 2 วินาที)

สามารถเปลี่ยนการตั้งค่าด้วย GT Designer3(GOT2000)

เมนูหลักของ utility จะแสดง

2.2.2 การตรวจสอบสถานะการเชื่อมต่อ
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2

2 สัมผัส [Maintenance] → [Ethernet status check] บนเมนูหลัก

ของ utility

3

3 ตั้งค่าที่อยู่ไอพีของตัวควบคุมปลายทางและสัมผัสปุ่ม [Ping 

transmission]

ในเอกสารนี้ที่อยู่ไอพีของตัวควบคุมปลายทางคือ 192.168.3.39 

(ค่าเริ่มต้น)

สามารถตรวจสอบและเปลี่ยนที่อยู่ไอพีของตัวควบคุมปลาย

ทางใน [Ethernet Setting] โดยการเลือก [Common] → 

[Controller Setting] จาก Menu bar ของ 

GT Designer3(GOT2000)

4

5

หากไม่มีข้อผิดพลาดด้านการสื่อสาร ข้อความ [Response received.] 

จะปรากฏ

4 สัมผัสปุ่ม [OK]

5 สัมผัสปุ่ม [×] เพื่อแสดงหน้าจอที่สร้าง
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เขียนโปรแกรมแลดเดอร์ ซึ่งถูกสร้างส�าหรับการจ�าลองเหตุการณ์จาก GX Works3 ไปยัง PLC

2.2.3 การเขียนโปรแกรมแลดเดอร์ไปยัง PLC
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บันทึก
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3

ขั้นตอนที่ 3 

การใช้งาน GOT
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สัมผัสแต่ละ switch เพื่อตรวจสอบแอคชันของ switch

(1) (2) (3)

(4)

ต่อไปนี้จะแสดงชุดแอคชันส�าหรับแต่ละวัตถุ

(1) RUN switch
การสัมผัส switch นี้จะเริ่มการปฏิบัติการ (M0 เปิด)

(2) STOP switch
การสัมผัส switch นี้จะหยุดการปฏิบัติการ (M1 เปิด)

(3) หลอดไฟ Running
RUN: หลอดไฟจะเปิดพร้อมกับข้อความ “RUN” (ขณะที่ M0 เปิด Y10 จะเปิด)

(Y10 เปิดโดยโปรแกรมแลดเดอร์)

STOP: หลอดไฟจะปิดพร้อมกับข้อความ “STOP” (ขณะที่ M1 เปิด Y10 จะปิด)

(Y10 ปิดโดยโปรแกรมแลดเดอร์)

(4) Data 1 (แสดงตัวเลข)
RUN: ค่าตัวเลข 6666 จะแสดง (ขณะที่ M0 เปิด)

(ค่า 6666 จะถูกบันทึกไว้ใน D10 โดยโปรแกรมแลดเดอร์)

STOP: ค่าตัวเลข 3333 จะแสดง (ขณะที่ M1 เปิด)

(ค่า 3333 จะถูกบันทึกไว้ใน D10 โดยโปรแกรมแลดเดอร์)

3.1 การตรวจสอบแอคชัน ON/OFF ของ switch
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1

1 การสัมผัส RUN switch จะเปิดหลอดไฟ Running และแสดง

ผล 6666 ใน Data 1

2

2 การสัมผั STOP switch จะเปิดหลอดไฟ Running และแสดงผล 

3333 ใน Data 1
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หน้าจอสามารถขยายและย่อโดยใช้ฟังก์ชันท่าทางหน้าจอ

1

1 สัมผัส switch ส�าหรับการเปลี่ยนไปยังโหมดท่าทางหน้าจอ

2

2 เส้นสีแดงแสดงถึงพื้นที่ที่สามารถขยายและย่อ

3

3 สามารถขยายและย่อหน้าจอโดยการหุบออกและเข้าภายใน

พื้นที่นี้

3.2 การใช้งานฟังก์ชันท่าทางหน้าจอ



3-5

3

54

4 หากต้องการยกเลิกโหมดท่าทางหน้าจอ ให้สัมผัส switch 

ส�าหรับการเปลี่ยนโหมดท่าทางหน้าจอ

โหมดท่าทางหน้าจอถูกยกเลิกและการแสดงผลหน้าจอยังคงมี

ขนาดใหญ่อยู่

5 หากต้องการเปลี่ยนเป็นแบบเต็มหน้าจอ สัมผัส switch การ

แสดงผลเต็มหน้าจอ (100%)

เมื่อการแสดงผลหน้าจอถูกเปลี่ยนเป็นเต็มหน้าจอระหว่าง

โหมดท่าทางหน้าจอ โหมดท่าทางหน้าจอจะถูกยกเลิกและหน้า

จอจะแสดงแบบเต็มหน้าจอ
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3.3 รายการของฟังก์ชันต่างๆ ของ GOT

GOT มีฟังก์ชันต่างๆ ที่มีประโยชน์ที่หลากหลาย ส่วนนี้จะแนะน�าบางฟังก์ชัน

สมัผสั switch เพื�อเปลี�ยนค่าของ
อุปกรณ์คาํ

สมัผสั switch เพื�อเปลี�ยนหนา้จอใหเ้ป็น
หนา้จอ utility หรือหนา้จออื�นๆ

Word switch Switch ฟังกช์นัพิเศษ

สมัผสั switch เพื�อเปลี�ยนหนา้จอพื�นฐานและ
หนา้จอหนา้ต่าง

Switch ปลี�ยนไปยงัหนา้จออื�น

Key window display switch

หนา้ต่างกญุแจที�ระบุจะแสดงที�
ตาํแหน่งที�ระบุ และเคอร์เซอร์จะแสดงบน
วตัถุที�ระบุ

สมัผสั switch เพื�อเปิดหรือปิดอุปกรณ์บิต

Bit switch

สมัผสั switch เพื�อเปลี�ยนหมายเลขสถานี
ของ PLC ที�จะเฝ้าระวงั

Switch เปลี�ยนหมายเลขสถานี

เปลี�ยน 
เป้าหมาย 
การเฝ้าระวงั

เปลี�ยนสีของหลอดไฟ

การแสดงผลหลอดไฟ

Key code switch

หนา้จอพื�นฐาน 1 หนา้จอพื�นฐาน 2

150 1500

สามารถใช ้switch นี� เป็นกญุแจสาํหรับ
ค่าตวัเลขหรือขอ้ความในการป้อน

หลอดไฟบิต

D100:

M0: ON → OFF

200 → 350
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ค่าจะถกูเขียนไปยงัอุปกรณ์

กรอกตวัเลข

ค่าของอุปกรณ์จะแสดงค่าตวัเลข

แสดงตวัเลข

334D100
45D100

รหสัอกัขระถกูป้อนไปยงัอุปกรณ์

A B C D

กรอกอกัษร

ค่าอุปกรณ์จะแสดงดว้ยอกัขระ

MITSUBISHI

แสดงอกัษร

STOP

แสดง comment

comment ถูกแสดง

RUN STOP

วนัที�และเวลาจะแสดง

แสดงนาฬิกา

07/08/24

15:27

ตวัเลข แสดงอกัษร

D100: 334 STOP
D100: 45

D10: 4241H (BA)
D11: 4443H (DC)

004D:
0049:
0054:
0053:
0055:
0042:
0049:
0053:
0048:
0049:

M
I
T
S
U
B
I
S
H
I

ชิ�นส่วน
การเคลื�อนไหวของชิ�นส่วนแสดงชิ�นส่วน

แสดงชิ�นส่วนที�ลงทะเบียน แสดงการเคลื�อนไหวของชิ�นส่วน

ชิ�นส่วน 1 ชิ�นส่วน 2
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กราฟ มิเตอร์ * ที�นี�จะแนะนาํเพียงบางฟังกช์นัเท่านั�น

แสดงกราฟสถิติ แสดงกราฟแนวโนม้ทางสถิติ

การแสดงระดบัการแสดแมิเตอร์

เงื�อนไข → การปฏิบติัการ
Time action functionLogging function

ค่าของอุปกรณ์จะแสดงดว้ยมิเตอร์

ค่าอุปกรณ์หลายอุปกรณ์จะแสดง 
ในกราฟดว้ยเปอร์เซ็นตร์วม

ค่าของอุปกรณ์จะแสดงดว้ย
เปอร์เซ็นตร์วม

กราฟพาย กราฟแท่ง

ขอ้มูลรวมถึงการรวบรวมขอ้มูลในอดีตและปัจจุบนั 
การใชฟั้งกช์นับนัทึกจะแสดงดว้ยกราฟแนวโนม้

ค่าอุปกรณ์จะถกูรวบรวมและเกบ็ไว้ สามารถเขียนอุปกรณ์ในวนัและเวลาที�ระบุ

Recipeตวัเลื�อน

Recipe functionตวัเลื�อน

สถานะของอุปกรณ์จะไดรั้บการเฝ้าระวงั และค่าของอุปกรณ์ 
จะถกูอ่านหรือเขียนเมื�อเป็นไปตามเงื�อนไข 
สามารถตั�งค่าหลายค่าสาํหรับหนึ�งอุปกรณ์ 
สามารถอ่านและเขียนค่าอุปกรณ์โดยใช ้utility

ใชต้วัเลื�อนในการตั�งค่าที�ต่อเนื�องใหก้บั
อุปกรณ์ภายในช่วงการตั�งค่า 
ค่าของปลายทางที�คุณหยดุปุ่มคืออินพตุของอุปกรณ์

การอ่าน/
การเขียน

การเปลี�ยนเอาทพ์ตุการตั�งค่า 
ดว้ยตวัเลื�อน

* ที�นี�จะแนะนาํเพียงบางฟังกช์นัเท่านั�น

→  

D100:
D101:
D102:

150 250
500300 
235208

Production line
Current output
Set output

Production line
Current output
Set output
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อื�นๆ

monitor อุปกรณ์ สาํรองขอ้มูล/คืนขอ้มูล

การเปลี�ยนภาษาแสดงเอกสาร

monitor สถานะของอุปกรณ์ PLC การตั�งค่าของตวัควบคุมสามารถสาํรองขอ้มูล
หรือคืนขอ้มูลจาก GOT

สามารถสลบัหลายภาษา 
เพื�อแสดงภาษาที�เหมาะสม

สามารถแสดงขอ้มูลเอกสารบน GOT

สาํรองขอ้มูล

คืนขอ้มูล

* ที�นี�จะแนะนาํเพียงบางฟังกช์นัเท่านั�น

English

Hello

M10  ●
M20  ○
D100  255

M10   ON
M20  OFF
D100 255

I/O ภายนอก * ที�นี�จะแนะนาํเพียงบางฟังกช์นัเท่านั�น

บาร์โคด้ แผงปฏิบติัการ

การแสดงวดีีโอรายงาน

ขอ้มูลที�อ่านดว้ยเครื�องอ่านบาร์โคด้
จะถกูเขียนไปยงัอุปกรณ์

อุปกรณ์จะถกูเขียนโดยการปฏิบติัการ
กบัแผงปฏิบติัการ

สร้างขอ้มูลเช่นการจดัการการผลิต
และสถานะการผลิตและพิมพข์อ้ความที�รวบรวม

ภาพการแสดงวดีิโอ

150
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3.4 ฟังก์ชันส�าหรับการบ�ารุงรักษา

แจง้เตือน

การแสดงผลการแจง้เตือนอยา่งง่าย การแสดงการแจง้เตือนของระบบ

แสดงหนา้จอแจง้เตือนแสดงการแจง้เตือน

แสดงขอ้ผดิพลาด GOT ขอ้ผดิพลาดการสื�อสาร 
ขอ้ความที�สร้างโดยผูใ้ชต้ามประวติัเมื�อเกิดการแจง้เตือน 
การแจง้เตือนจะแสดงเป็นลาํดบัชั�น

แสดงขอ้ผดิพลาด GOT ขอ้ผดิพลาดการสื�อสาร 
ขอ้ความที�สร้างโดยผูใ้ชด้ว้ยหนา้ต่างป๊อบอพั
เมื�อเกิดการแจง้เตือน

แสดงผลขอ้ความที�สร้างโดยผูใ้ช ้
เมื�อเกิดการแจง้เตือน

แสดงผลขอ้ผดิพลาด GOT และขอ้ผดิพลาดการสื�อสาร 
เมื�อเกิดการแจง้เตือน

13:25 Line A stop

13:25 Line A stop
13:05 Upper limit over
13:03 Motor trip

Time  Message

02/04/18  13:25:40

Line stop

307 No monitor device 
is set.

ฟังกช์นัเชื�อมต่อ GOT ผา่นมือถือ
ฟังกช์นันี�จะ monitor อุปกรณ์ที�เชื�อมต่อผา่น GOT จากอุปกรณ์ เช่น 
คอมพิวเตอร์ส่วนบุคคล แทบ็เลต็ และสมาร์ทโฟน
ผูใ้ชส้ามารถรับสถานะของอุปกรณ์ไดอ้ยา่งง่ายในพื�นที�จากสถานที�ที�ห่างออกไป
อุปกรณ์ขอ้มูลหา้ชุดสามารถเชื�อมต่อกบัยนิูต GOT หนึ�งยนิูตในเวลาเดียวกนั

2 3

41 5

สมาร์ทโฟน แทบ็เลต็แทบ็เลต็GOT

PCPC และมอนิเตอร์หนา้จอขนาดใหญ่

ไซต์
การผลิต

สาํนกังาน

สถานที�หรือสาํนกังานระยะไกล
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ฟังกช์นัการดูบนัทึก

Date and time

2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line 1
100
98
95
92

Line 2
250
260
270
280

Line 3

แมว้า่จะไม่ไดติ้ดตั�งคอมพิวเตอร์ส่วนบุคคลบนไซตใ์นพื�นที� GOT สามารถรับ (บนัทึก) และ

แสดงขอ้มูลในอุปกรณ์ที�เชื�อมต่อ เช่น ตวัควบคุมที�โปรแกรมไดโ้ดยใชฟั้งกช์นันี�  เพื�อที�

สามารถการทาํการอยา่งรวดเร็วต่อปัญหาที�เกิดขึ�นที�ไซตใ์นพื�นที�

ฟังกช์นัของขอ้มูลบนัทึกการปฏิบติัการ
ฟังกช์นันี�บนัทึกการปฏิบติัการที�ดาํเนินการโดยผูใ้ชไ้ปยงั GOT ในที�เกบ็ขอ้มูลตามการตั�งค่า

สามารถใชก้ารปฏิบติัการที�บนัทึกไวใ้นการตรวจสอบหาสาเหตุ หากเกิดปัญหา

รายการขอ้มูลบนัทึกการปฏิบติัการ

การยนืยนัเคา้โครงของบนัทึก

ขอ้มูลรายละเอียด

การยนืยนัรายละเอียดบนัทึก

การบนัทึกการรับขอ้มูล ที�เกบ็ขอ้มูล

Date and time
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line 1
100
98
95
92

Line 2
250
260
270
280

Line 3

150
152
158
170

Line 1
100
98
95
92

Line 2
250
260
270
280

Line 3

Date and time
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line 1
100
98
95
92

Line 2
250
260
270
280

Line 3

กาํลงับนัทึกขอ้มูล กาํลงับนัทึกขอ้มูล
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ตวัอยา่งหนา้จอ

หนา้จอต่างๆ เรียงรายอยูเ่พื�อแสดงฟังกช์นัที�ใชง้านบ่อยบนไซตใ์นพื�นที�
โดยการอา้งอิงถึงตวัอยา่งหนา้จอต่างๆ ผูใ้ชไ้ม่จาํเป็นตอ้งสร้างหนา้จอที�เหมือนกนัตั�งแต่ตน้
หากคุณตอ้งการตวัอยา่งจอภาพ กรุณาปรึกษาตวัแทนของ Mitsubishi หรือสาํนกังานสาขาที�อยูใ่กลคุ้ณ

การแสดงผลกราฟแนวโนม้ การแสดงผลตวันบั การตั�งค่าพารามิเตอร์

Manual_Operation Current_Alarm_Display

รหสัผา่น
สามารถตั�งค่าสิทธิ� ในการปฏิบติัการและเรียกดู GOT โดยการตั�งค่าชื�อผูป้ฏิบติัและ รหสัผา่นสาํหรับผูใ้ชแ้ต่ละคน
การตั�งค่ารหสัผา่นทาํใหเ้กิด “การเพิ�มการรักษาความปลอดภยั” และ “การควบคุมการเขา้ถึงสาํหรับผูใ้ชแ้ต่ละคน”
ดว้ยการผสมผสานรหสัผา่นและฟังกช์นัขอ้มูลบนัทึกการปฏิบติัการ ทาํใหส้ามารถตรวจสอบวา่ “ใคร 
(บุคคล) เมื�อไร (วนัที�และเวลา) อะไร (ขอ้มูลเป้าหมาย) และอยา่งไร (วธีิการ)” ของแต่ละการปฏิบติัการที�ดาํเนินการ

ลอ็กอิน 
ไดรั้บอนุญาต

ผูป้ฏิบติั A 
มีสิทธิ� ใน 

การปฏิบติัการ

ผูป้ฏิบติั B 
ไม่มีสิทธิ� ใน 

การปฏิบติัการ

ลอ็กอิน 
ไม่ไดรั้บอนุญาต
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4

ขั้นตอนที่ 4 

การบ�ารุงรักษา GOT
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อุปกรณ์ FA สามารถรองรับสภาพแวดล้อมที่หลากหลาย รวมถึงการเปลี่ยนแปลงของอุณหภูมิและการสั่นสะเทือน และท�าหน้าที่เป็นแรงขับหลักของไซต์การ

ผลิต

อย่างไรก็ตามอุปกรณ์ FA เป็นอุปกรณ์อิเล็กทรอนิกส์ความเที่ยงตรงสูง และอาจไม่ท�างานอย่างกะทันหัน โดยเฉพาะ GOT ที่ติดตั้งบนพื้นผิวของแผงควบคุม

สามารถได้รับผลกระทบจากความดันภายนอกอย่างง่ายดาย 

หากมีความล้มเหลวของอุปกรณ์ FA อย่างต่อเนื่องเป็นเวลานาน ผลิตผลอาจลดลงอย่างมาก มีความจ�าเป็นที่จะต้องกู้คืนอุปกรณ์ FA ให้เร็วที่สุด

ช่วงเวลาระหว่างที่อุปกรณ์หยุดเนื่องจากความล้มเหลวจะเรียกว่า “เวลาที่ไม่สามารถปฏิบัติงานได้”

บทที่ 4 จะอธิบายพื้นฐานสามข้อต่อไปนี้ของการบ�ารุงรักษาที่จ�าเป็นส�าหรับการคงสถานะปกติของ GOT:

1. ส�ารองข้อมูล

2. แจ้งเตือน

3. แบตเตอรี่

4.1 ความจ�าเป็นในการบ�ารุงรักษา
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4

หากเป็นไปได้ให้ส�ารองข้อมูล GOT และข้อมูลของอุปกรณ์ที่เชื่อมต่อ

หากต้องการส�ารองข้อมูล ใช้ฟังก์ชัน utility ของ GOT

ฟังก์ชัน utility ได้รับการออกแบบมาส�าหรับการเชื่อมต่อ GOT และอุปกรณ์ต่างๆ ตั้งค่าข้อมูลบนหน้าจอ ตั้งค่าขั้นตอนการปฏิบัติการ จัดการโปรแกรม/ข้อมูล 

และท�าการวินิจฉัยตัวเอง

ก่อนท�าการส�ารองข้อมูล

หากต้องการส�ารองข้อมูล มีความจ�าเป็นที่จะต้องติดตั้งแอปพลิเคชันของระบบ (ฟังก์ชันส่วนขยาย) บนไดร์ฟ C ของ GOT (หน่วยความจ�าแฟลชในเครื่อง)

(1) การติดตั้งแอปพลิเคชันของระบบ (ฟังก์ชันส่วนขยาย)

ก่อนการติดตั้งแอปพลิเคชันของระบบ (ฟังก์ชันส่วนขยาย) ให้ท�าการ

ตั้งค่าต่อไปนี้

→  2.1.1 การเชื่อมต่อคอมพิวเตอร์ส่วนบุคคลกับ GOT

→ 2.1.2 การตั้งค่าการสื่อสาร

คลิก!

1

1 คลิกปุ่ม [Write Option]

ข้อความ [Write Option] จะแสดงผล

คลิก!

2

2 คลิกปุ่ม [Application Selection]

4.2 ส�ารองข้อมูล
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ข้อความ [Application Selection] จะแสดง

3

4

คลิก!

คลิก!

3

4

กาเครื่องหมายที่ [Backup/Restoration]

คลิกปุ่ม [OK]

คลิก!

5

5 คลิกปุ่ม [GOT Write] และการเขียนจะเริ่มต้น
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4

การส�ารองข้อมูลคือการท�าส�าเนาของข้อมูล

หากอุปกรณ์ใดๆ ไม่ท�างานหรือต้องท�าการเปลี่ยนเป็นอุปกรณ์ใหม่ สามารถกู้คืนข้อมูลในอุปกรณ์จากส�าเนาการส�ารองข้อมูล

ส�าหรับ GOT มีวิธีการส�ารองข้อมูลสองวิธี วิธีหนึ่งคือการเชื่อมต่อกับคอมพิวเตอร์ส่วนบุคคล และอีกวิธีหนึ่งคือการใช้เอสดีการ์ด

ในเวลานี้ โดยมีสมมติฐานว่าไม่มี คอมพิวเตอร์ส่วนบุคคลหรือไม่สามารถน�ามาที่ไซต์ได้ จะอธิบายกระบวนการส�ารองข้อมูลบนเอสดีการ์ด

ฟังก์ชั่นการส�ารอง แพ็คเกจข้อมูล GOT

เพื่อท�าการส�ารองข้อมูลที่ติดตั้งในยูนิตหลักของ GOT ใช้ฟังก์ชันรับแพ็คเกจข้อมูล GOT

ฟังก์ชันการรับแพ็คเกจข้อมูล GOT ได้รับการออกแบบเพื่อคัดลอกข้อมูลทั้งหมดที่ติดตั้งในยูนิตหลักของ GOT ลงในเอสดีการ์ด (การรับแพ็คเกจข้อมูล GOT)

สามารถติดตั้งข้อมูลที่คัดลอกบน GOT อื่นเพื่อสร้างระบบ GOT เดียวกัน (การติดตั้งข้อมูล GOT)

ขั้นตอนการท�างาน

GOT GOT

เอสดีการ์ด

การติดตั�งขอ้มูล GOT
(การคืนขอ้มูล)

การรับแพค็เกจ 
ขอ้มูล GOT (สาํรองขอ้มูล)

4.2.1 การส�ารองข้อมูล GOT
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(1) ขั้นตอนการรับข้อมูล (ส�ารองข้อมูล) แพ็คเกจข้อมูล GOT

1

1 สัมผัส [Utility call key]

2

2 สัมผัส [Backup Restoration] บนหน้าจอ [Data mng.] ใน 

[Utility main menu]

3

3 สัมผัส [GOT data package acquisition (GOT data)]
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4

4

5

4

5

การสัมผัสชื่อไดร์ฟด้านล่าง [Select Drive] จะแปลงเป็นชื่อ

ไดร์ฟที่สัมผัส

การสัมผัสปุ่ม [Copy] จะเริ่มการคัดลอก

หลังจากการคัดลอกแอปพลิเคชันและข้อมูลของระบบ กล่องข้อความ

ส�าหรับการแจ้งเตือนความสมบูรณ์จะปรากฏ

6

6 การสัมผัสปุ่ม [OK] จะปิดกล่องข้อความ

จากนั้น การรับข้อมูล (ส�ารองข้อมูล) แพ็คเกจข้อมูล GOT จะสมบูรณ์
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(2) ขั้นตอนส�าหรับการติดตั้ง (การคืนข้อมูล) ข้อมูล GOT

switch การติดตั�ง
(S.MODE)

2

1

2

ปิดระบบ GOT และใส่เอสดีการ์ดที่เก็บข้อมูลลงใน 

อินเตอร์เฟซเอสดีการ์ดของ GOT

ส�าหรับขั้นตอนในการใส่เอสดีการ์ด โปรดดูหัวข้อต่อไปนี้ 

(หน้า ผนวก 2-9 ในข้อความนี้)

→  ผนวก 2-7 การใส่/การถอดเอสดีการ์ด

เปิดระบบ GOT ในขณะที่กด switch ติดตั้งค้างไว้ (switch 

S.MODE) ที่ด้านหลังของ GOT

O  K ยกเลิก3

Do you want to execute installation?
3 สัมผัส [OK] ข้อมูลจะถูกติดตั้งบนหน่วยความจ�าแฟลชใน

เครื่อง

Install now...
4 LED การเข้าถึงเอสดีการ์ดจะสว่างระหว่างการด�าเนินการติดตั้ง

ห้ามดึงเอสดีการ์ดออก หรือปิดระบบ GOT ระหว่างที่ LED 

การเข้าถึงเอสดีการ์ดสว่างอยู่
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4

O  K 5

Installation has been completed.
5 สัมผัส [OK] GOT จะเริ่มการท�างานใหม่โดยอัตโนมัติ

6 หลังจากการยืนยันการเริ่มการท�างานใหม่ปกติ โปรดยืนยันว่า 

LED การเข้าถึงเอสดีการ์ดไม่สว่าง และถอดเอสดีการ์ด

ออกจากอินเตอร์เฟซเอสดีการ์ดของ GOT

ส�าหรับขั้นตอนในการถอดเอสดีการ์ด โปรดดูหัวข้อต่อไปนี้ 

(หน้า ผนวก 2-9 ในข้อความนี้)

→  ผนวก 2-7 การใส่/การถอดเอสดีการ์ด

จากนั้นการติดตั้ง (การกู้คืน) ข้อมูล GOT จะเสร็จสมบูรณ์
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การตั้งค่าข้อมูล รวมถึงโปรแกรมอนุกรม พารามิเตอร์ และค่าที่ตั้งส�าหรับตัวควบคุมที่เชื่อมต่อกับ GOT สามารถบันทึก (ส�ารองข้อมูล) ในหน่วยความจ�าหรือ

หน่วยความจ�า USB ใน GOT

ด้วยการส�ารองข้อมูลการตั้งค่าส�าหรับตัวควบคุม สามารถกู้คืนข้อมูลไปยังตัวควบคุมด้วย GOT ที่เชื่อมต่อกับตัวควบคุม แม้ว่าจะต้องเปลี่ยนตัวควบคุม

เนื่องจากปัญหาต่างๆ รวมถึงความล้มเหลวในการท�างาน ผลลัพธ์คือ สามารถคืนข้อมูลให้ระบบได้อย่างง่ายดาย

ฟังก์ชันการส�ารองข้อมูล (อุปกรณ→์GOT)

ฟังก์ชันการส�ารองข้อมูลถูกใช้ในการคัดลอกข้อมูลในอุปกรณ์ที่เชื่อมต่อกับ GOT ลงในเอสดีการ์ด

ฟังก์ชันการคืนข้อมูล (GOT→อุปกรณ์)

ฟังก์ชันการคืนข้อมูลถูกใช้ในการคืนข้อมูลอุปกรณ์ที่บันทึกไว้ในเอสดีการ์ดไปยังอุปกรณ์

ขั้นตอนการท�างาน

GOT

อุปกรณ์

สาํรองขอ้มูลการตั�งค่า
ไปยงัเอสดีการ์ด

คืนขอ้มูลการสาํรองขอ้มูล
ไปยงัตวัควบคุม

เอสดีการ์ด

4.2.2 การส�ารองข้อมูลอุปกรณ์ที่ท�าการเชื่อมต่อ
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4

(1) การตั้งค่าปลายทางเพื่อบันทึกข้อมูลการส�ารองข้อมูล

1

1 สัมผัส [Utility call key]

2

2 สัมผัส [Backup Restoration] บนหน้าจอ [Ext. func. set] ใน 

[Utility main menu]

3

4

3 หากสัมผัสรายการตั้งค่า เนื้อหาในการตั้งค่าจะเปลี่ยนไป

ตั้งค่า “Drive for backup data” ให้เป็น [A: Built-in SD card]

4 หากสัมผัสปุ่ม [OK] ในหน้าก่อนหน้านี้ การตั้งค่าที่เปลี่ยนไป

จะแสดงผลและหน้าจอจะกลับไปยังหน้าจอ [Ext. func. set]
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(2) ฟังก์ชันการปฏิบัติการและการส�ารองข้อมูล (อุปกรณ์→GOT)

1

1 สัมผัส [Utility call key]

2

2 สัมผัส [Backup restration] บนหน้าจอ [Data mng.] ใน [Utility 

main menu]

3

3 สัมผัส [Backup function (Device→GOT)]
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4

4

4 หน้าต่างที่แสดงด้านซ้ายจะแสดงผล สัมผัสปุ่ม [OK]

“Backing up” กระพริบในคอลัมน์ Status

5 การส�ารองข้อมูลในอุปกรณ์ที่เชื่อมต่อจะเริ่มการท�างาน

6

หลังจากที่การส�ารองข้อมูลในอุปกรณ์ที่เชื่อมต่อเสร็จสิ้น หน้าต่าง

ข้อความเสร็จสมบูรณ์จะแสดงผล

6 สัมผัสปุ่ม [OK]

7

“Completed” จะแสดงผลในคอลัมน์สถานะ

7 สัมผัสปุ่ม [Close]

จากนั้น การส�ารองข้อมูล (อุปกรณ์→GOT) จะสมบูรณ์
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(3)  การปฏิบัติการฟังก์ชันการคืนข้อมูล (GOT→อุปกรณ์)

1

1 สัมผัส [Utility call key]

2

2 สัมผัส [Backup restration] บนหน้าจอ [Data mng.] ใน [Utility 

main menu]

3

3 สัมผัส [Restoration function (GOT→Device)]
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4

4 5

6

ข้อมูลการส�ารองข้อมูลที่เก็บอยู่ในเอสดีการ์ดจะแสดงผลในแบบ

ฟอร์มรายการ

4

5

6

เลือกข้อมูลการส�ารองข้อมูลที่จะคืนข้อมูลโดยการสัมผัสกับ

ข้อมูล

สัมผัสชื่อชื่อข้อมูล (อุปกรณ์เชื่อมต่อที่จะคืนข้อมูล)

สัมผัสปุ่ม [Execute]

7

7 หน้าต่างที่แสดงด้านซ้ายจะแสดงผล สัมผัสปุ่ม [OK]

8

จากนั้นหน้าต่างแสดงผลทางด้านซ้ายมือ เป็นไปได้ที่จะเลือกว่า 

จะเก็บข้อมูลไว้ใน File Register ที่อยู่ใน PLC หรือไม่ ส�าหรับ 

รายละเอียดของ File Register โปรดดูคู่มือส�าหรับ PLC ที่จะใช้งาน

8 สัมผัสปุ่ม [Yes]

“Restoring” จะกระพริบในคอลัมน์ Status

9 การคืนข้อมูลในอุปกรณ์ที่เชื่อมต่อจะเริ่มต้น
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10

หลังจากที่การคืนข้อมูลในอุปกรณ์ที่เชื่อมต่อเสร็จสิ้น กล่องข้อความ

เสร็จสมบูรณ์จะแสดงผล

10 สัมผัสปุ่ม [OK]

11

“Completed” จะแสดงผลในคอลัมน์สถานะ

11 สัมผัสปุ่ม [Close]

จากนั้น การคืนข้อมูล (GOT→Device) จะสมบูรณ์
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4

To/From ยังอุปกรณ์ที่เชื่อมต่อซึ่งจะท�าการส�ารองข้อมูล/คืนข้อมูล

ส�าหรับการตั้งค่าชนิดการเชื่อมต่อและ ข้อควรระวังเบื้องต้นที่เกี่ยวกับยูนิต/สายเคเบิลการสื่อสาร และชนิดการเชื่อมต่อ โปรดดูเอกสารต่อไปนี้

→GOT2000 Series Connection Manual (Mitsubishi Products) For GT Works3 Version1

→GOT2000 Series User’s Manual (Monitor)

ตัวควบคุม รุ่น

RCPU R04CPU, R08CPU, R16CPU, R32CPU, R120CPU

CPU ตัวควบคุมการเคลื่อนไหว (ซีรีส์ MELSEC iQ-R) R16MTCPU, R32MTCPU

QCPU (Q-Mode) รุ่น Basic Q00JCPU, Q00CPU, Q01CPU

รุ่น Highperformance Q02CPU, Q02HCPU, Q06HCPU, Q12HCPU, Q25HCPU, Q02PHCPU, Q06PHCPU, 

Q12PHCPU, Q25PHCPU

รุ่น Universal Q00UJCPU, Q00UCPU, Q01UCPU, Q02UCPU, Q03UDCPU, Q04UDHCPU, 

Q06UDHCPU, Q10UDHCPU, Q13UDHCPU, Q20UDHCPU, Q26UDHCPU, 

Q03UDECPU, Q04UDEHCPU, Q06UDEHCPU, Q10UDEHCPU, Q13UDEHCPU, 

Q20UDEHCPU, Q26UDEHCPU, Q50UDEHCPU, Q100UDEHCPU, Q03UDVCPU, 

Q04UDVCPU, Q06UDVCPU, Q13UDVCPU, Q26UDVCPU

CPU Motion Controller (Q-Series) Q172CPU, Q173CPU, Q172HCPU, Q173HCPU, Q172DCPU, Q172DCPU-S1, 

Q173DCPU, Q173DCPU-S1, Q172DSCPU, Q173DSCPU, Q170MCPU, 

Q170MCPU-S1, Q170MSCPU, Q170MSCPU-S1

LCPU L02CPU, L06CPU, L26CPU, L26CPU-BT, L26CPU-PBT, L02CPU-P, L02SCPU

FXCPU FX0, FX0S, FX0N, FX1, FX2, FX2C, FX1S, FX1N, FX1NC, FX2N, FX2NC, FX3U, FX3UC, FX3G

CNC C80 R16NCCPU

CNC C70 Q173NCCPU

MELSERVO-J Series 4 MR-J4-GF

FREQROL-Series A FREQROL-A800 Series, FREQROL-A800 Plus Series

Robot Controller CRnQ-700, CR750-Q, CR751-Q, CRnD-700, CR750-D, CR751-D
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(1) ชนิดการแจ้งเตือน
GOT มีฟังก์ชันการแจ้งเตือนสองประเภท

(a) การแจ้งเตือนของระบบ

ฟังก์ชันนี้จะแสดงรหัสข้อผิดพลาดและข้อความ Error เมื่อเกิดข้อผิดพลาดใน GOT หรืออุปกรณ์ที่เชื่อมต่อใดๆ ภายเครือข่าย

400 The communication 

with CPU failed. 16:40:30

9  AC down has been detected.

803 The transient error has occurred.

ขอ้ผดิพลาด
เกิดขึ�น

(b) การแจ้งเตือนของผู้ใช้

ฟังก์ชันนี้จะแสดงข้อคิดเห็นที่สร้างโดยผู้ใช้เป็นข้อความแจ้งเตือนเมื่อเกิดการแจ้งเตือนขึ้น

ใช้ฟังก์ชันนี้เมื่อก�าลังแสดงการแจ้งเตือนที่สร้างโดยผู้ใช้

ส�าหรับรายละเอียดเกี่ยวกับการแจ้งเตือนของผู้ใช้ โปรดดูคู่มือต่อไปนี้

→GT Designer3(GOT2000) Screen Design Manual

Touch

Error date and time Comment

May 1, 2004 Fuse error

May 1, 2004 Oil error

May 1, 2004 Temperature anomaly

Detail

Replace the fuse of 

the power supply unit.

M100: OFF → ON
M101: OFF → ON

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Detail

4.3 แจ้งเตือน
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4.3.1 การตรวจสอบระบบการแจ้งเตือน

(1) ขั้นตอนส�าหรับการตรวจสอบการแจ้งเตือนของระบบ

1

1 สัมผัส [Utility call key]

2

2 สัมผัส [System alarm] บนหน้าจอ [Maintenance] ใน [Utility 

main menu]

รหสัผดิพลาด

ขอ้ความ Error

หน้าต่างการแจ้งเตือนของระบบจะแสดง

ส�าหรับการแจ้งเตือนของระบบ โปรดดูเอกสารต่อไปนี้ (หน้า 

ผนวก 1-1 ในข้อความนี้)

→  ภาคผนวก 1 รหัสผิดพลาดและรายการแจ้งเตือนของระบบ
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(2) การรีเซ็ตการแสดงผลการแจ้งเตือนของระบบ

1 Clear สาเหตุแต่ละสาเหตุที่ท�าให้เกิดการแจ้งเตือนของระบบ

สามารถระบุข้อผิดพลาดที่เป็นสาเหตุได้จากรหัสข้อผิดพลาด 

ข้อความ Error และหมายเลขแชนแนลที่แสดงบนหน้าจอการ

แจ้งเตือนของระบบ

→  ภาคผนวก 1 รหัสผิดพลาดและรายการแจ้งเตือนของระบบ

2

2 สัมผัสปุ่ม [Reset] เพื่อรีเซ็ตการแจ้งเตือนของระบบ

อย่างไรก็ตาม หากยังไม่ได้แก้ไขสาเหตุของการแจ้งเตือนของ

ระบบ การแสดงการแจ้งเตือนของระบบจะไม่ถูกรีเซ็ตแม้ว่าจะ

ท�าการรีเซ็ตแล้ว ดังนั่้นจะต้องท�าการตรวจสอบระบบใหม่
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4

แบตเตอรี่ถูกใช้เพื่อเก็บข้อมูลใน SRAM, ข้อมูลนาฬิกา และข้อมูลการส�ารองข้อมูลส�าหรับข้อมูลบันทึกสถานะของระบบ

แนะน�าให้ท�าการเปลี่ยนแบตเตอรี่ตามระยะเวลา

ส�าหรับรายละเอียดของการแสดงผลสถานะแบตเตอรี่ โปรดดูหัวข้อต่อไปนี้ (หน้า 4-28 ในข้อความนี้)

→ 4.4.3 การตรวจสอบแรงดันไฟฟ้าแบตเตอรี่

การติดตั้งแบตเตอรี่กับ GOT ก่อนการเริ่มการท�างานครั้งแรก

ขั้นตอนในการติดตั้งและถอดแบตเตอรี่เป็นตัวอย่างกับ GT27 จะแสดงไว้ด้านล่าง (ด้านหลังของ GOT จะหันไปทางด้านบนตามภาพประกอบ)

Points

(1) แบตเตอรี่

GT27 จะมีแบตเตอรี่ติดตั้งมาด้วยในที่ยึดแบตเตอรี่ ก่อนการใช้ GT27 เชื่อมต่อ connector ของแบตเตอรี่กับ connector ของ

 

(2) เวลาในการเปลี่ยนแบตเตอรี่

หากต้องการเปลี่ยนแบตเตอรี่ ให้เปิด GOT ทิ้งไว้นานกว่า 10 นาทีก่อนท�าการเปลี่ยนแบตเตอรี่ เปลี่ยนแบตเตอรี่ภายในเวลา 5 นาที

ขั้นตอนในการติดตั้งแบตเตอรี่จะแตกต่างกันออกไปโดยขึ้นกับรุ่นของ GOT

 ● GT2715, GT2712, GT2710

ต่อไปนี้จะแสดงขั้นตอนการติดตั้งแบตเตอรี่ โดยใช้ GT2712 เป็นตัวอย่าง

1 ตรวจสอบให้แน่ใจว่าปิด GOT แล้ว

ฝาปิดแบตเตอรี� 2 ติดตั้งแบตเตอรี่กับด้านหลังของ GOT

เปิดฝาปิดแบตเตอรี่ตามที่แสดงด้านซ้าย

3 หากต้องการเปลี่ยนแบตเตอรี่ ให้ถอดแบตเตอรี่เก่าออกจาก 

นั้นปลด Connector

4.4 แบตเตอรี่

4.4.1 การติดตั้งแบตเตอรี่
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 ● ไม่มีสายเคเบิลต่อพ่วงแบตเตอรี่

ฝาปิดแบตเตอรี�

ไม่มีสายเคเบิลต่อพว่งแบตเตอรี�

แบตเตอรี� Connector

สายเคเบิลสีดาํ

สายเคเบิลสีแดง

4 Connector ด้าน GOT ขึ้นอยู่กับว่า GOT มีสายเคเบิลต่อพ่วง
แบตเตอรี่หรือไม่
•  ไม่มีสายเคเบิลต่อพ่วงแบตเตอรี่ 

ใส่ Connector แบตเตอรี่ไปที่ Connector GOT
•  มีสายเคเบิลต่อพ่วงแบตเตอรี่ 

ใส่ Connector แบตเตอรี่ที่ Connector สายต่อพ่วงแบตเตอรี่
ของ GOT

รุ่น GT27 ที่มีเวอร์ชันฮาร์ดแวร์ต่อไปนี้จะไม่มีสายเคเบิลต่อ
พ่วงแบตเตอรี่
•  GT2715: เวอร์ชัน G หรือเวอร์ชันใหม่กว่า (ผลิตในกันยายน 

2014)
•  GT2712: เวอร์ชัน M หรือเวอร์ชันที่ใหม่กว่า (ผลิตใน

กันยายน 2014)
•  GT2710: เวอร์ชัน N หรือเวอร์ชันที่ใหม่กว่า (ผลิตในกันยายน 

2014)

 ● มีสายเคเบิลต่อพ่วงแบตเตอรี่

ฝาปิดแบตเตอรี�สายเคเบิลต่อพว่งแบตเตอรี�

แบตเตอรี�

สายเคเบิลสีดาํ

สายเคเบิลสีแดง

สายเคเบิลสีแดง

Connector

สายเคเบิลสีดาํ

ฝาปิดแบตเตอรี�แบตเตอรี�

Connector

5 หลังจากการติดตั้งแบตเตอรี่กับที่ยึดแบตเตอรี่ของ GOT ปิดฝา

ปิดแบตเตอรี่จนกว่าจะได้ยินเสียงคลิก
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6 เปิด GOT

7 ตรวจสอบสภาพของแบตเตอรี่ว่าปกติหรือไม่ด้วย utility

ส�าหรับรายละเอียดเกี่ยวกับการแสดงผลสภาพของแบตเตอรี่ 

โปรดดูเอกสารต่อไปนี้ (หน้า 4-28 ในข้อความนี้)

→ 4.4.3 การตรวจสอบแรงดันไฟฟ้าแบตเตอรี่

 ● GT2708, GT2705

ต่อไปนี้จะแสดงขั้นตอนการติดตั้งแบตเตอรี่ โดยใช้ GT2708 เป็นตัวอย่าง

1 ตรวจสอบให้แน่ใจว่าปิด GOT แล้ว

ฝาปิดเอสดีการ์ด 2 ติดตั้งแบตเตอรี่ด้านในฝาปิดเอสดีการ์ดที่ด้านข้างของ GOT

เปิดฝาปิดเอสดีการ์ดตามที่แสดงด้านซ้าย

3 ถอดแบตเตอรี่เก่าออก จากนั้นปลด Connector

ส�าหรับข้อมูลเกี่ยววิธีถอดแบตเตอรี่ โปรดดูต่อไปนี้

ฝาปิดเอสดีการ์ด

แบตเตอรี�

Connector

สายเคเบิลสีดาํ

สายเคเบิลสีแดง

4 ใส่ Connector แบตเตอรี่กับ Connector GOT
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ฝาปิดเอสดีการ์ดแบตเตอรี�

คอนเนคเตอร์

5 หลังจากการติดตั้งแบตเตอรี่กับที่ยึดแบตเตอรี่ของ GOT ปิดฝา

ปิดเอสดีการ์ดจนกว่าจะได้ยินเสียงคลิก

6

7

เปิด GOT

ตรวจสอบสภาพของแบตเตอรี่ว่าปกติหรือไม่ด้วย utility

ส�าหรับรายละเอียดเกี่ยวกับการแสดงผลสภาพของแบตเตอรี่ 

โปรดดูเอกสารต่อไปนี้ (หน้า 4-28 ในข้อความนี้)

→ 4.4.3 การตรวจสอบแรงดันไฟฟ้าแบตเตอรี่
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ขั้นตอนในการถอดแบตเตอรี่จะแตกต่างกันออกไปโดยขึ้นกับรุ่นของ GOT

 ● GT2715, GT2712, GT2710

ต่อไปนี้จะแสดงขั้นตอนการถอดแบตเตอรี่ โดยใช้ GT2712 เป็นตัวอย่าง

1 ตรวจสอบให้แน่ใจว่าปิด GOT แล้ว

ฝาปิดแบตเตอรี�แบตเตอรี�

Connector

2 แบตเตอรี่ถูกเก็บไว้ที่ด้านหลังของ GOT

เปิดฝาปิดแบตเตอรี่ตามที่แสดงด้านซ้าย

 ● ไม่มีสายเคเบิลต่อพ่วงแบตเตอรี่

ฝาปิดแบตเตอรี�

แบตเตอรี�

สายเคเบิลสีดาํ

สายเคเบิลสีแดง

คอนเนคเตอร์

3 หลังจากการถอดแบตเตอรี่ออกจากที่ยึดแบตเตอรี่ของ GOT ให้

ท�าการถอดปลั๊ก connector

ด้าน Connector ของ GOT ขึ้นอยู่กับว่า GOT มีสายเคเบิลต่อ

พ่วงแบตเตอรี่หรือไม่

•  ไม่มีสายเคเบิลต่อพ่วงแบตเตอรี่ 

ปลด connector แบตเตอรี่ออกจาก connector  GOT

•  มีสายเคเบิลต่อพ่วงแบตเตอรี่ 

ปลด connector แบตเตอรี่ออกจากสายต่อพ่วงแบตเตอรี่ของ 

GOT

รุ่น GT27 ที่มีเวอร์ชันฮาร์ดแวร์ต่อไปนี้จะไม่มีสายเคเบิลต่อ

พ่วงแบตเตอรี่

•  GT2715: เวอร์ชัน G หรือเวอร์ชันใหม่กว่า (ผลิตในกันยายน 

2014)

•  GT2712: เวอร์ชัน M หรือเวอร์ชันที่ใหม่กว่า (ผลิตใน

กันยายน 2014)

•  GT2710: เวอร์ชัน N หรือเวอร์ชันที่ใหม่กว่า (ผลิตในกันยายน 

2014)

4.4.2 การถอดแบตเตอรี่
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 ● มีสายเคเบิลต่อพ่วงแบตเตอรี่

ฝาปิดแบตเตอรี�สายเคเบิลต่อพว่งแบตเตอรี�

แบตเตอรี�

สายเคเบิลสีดาํ

สายเคเบิลสีแดง

สายเคเบิลสีแดง

connector

สายเคเบิลสีดาํ

ฝาปิดแบตเตอรี� 4 ดึงและปิดฝาปิดแบตเตอรี่จนกว่าจะได้ยินเสียงคลิก
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 ● GT2708, GT2705

ต่อไปนี้จะแสดงขั้นตอนการถอดแบตเตอรี่ โดยใช้ GT2708 เป็นตัวอย่าง

1 ตรวจสอบให้แน่ใจว่าปิด GOT แล้ว

ฝาปิดเอสดีการ์ดแบตเตอรี�

คอนเนคเตอร์

2 แบตเตอรี่ถูกเก็บไว้ด้านในฝาปิดเอสดีการ์ดที่ด้านข้างของ GOT

เปิดฝาปิดเอสดีการ์ดตามที่แสดงด้านซ้าย

ฝาปิดเอสดีการ์ด

แบตเตอรี�

คอนเนคเตอร์

สายเคเบิลสีดาํ

สายเคเบิลสีแดง

3 หลังจากการถอดแบตเตอรี่ออกจากที่ยึดแบตเตอรี่ของ GOT 

ปลดคอนเนคเตอร์แบตเตอรี่ออกจากคอนเนคเตอร์ GOT

ฝาปิดเอสดีการ์ด 4 ปิดฝาปิดเอสดีการ์ดจนกระทั่งได้ยินเสียงคลิก
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สามารถตรวจสอบแรงดันไฟฟ้าแบตเตอรี่ได้สองวิธี

● การตรวจสอบที่เมนู utility

● การตรวจสอบบนหน้าจอการแจ้งเตือนของระบบ

(1) วิธีการในการตรวจสอบบนเมนู utility

1

1 สัมผัส [Utility call key]

2

2 สัมผัส [Time] บนหน้าจอ [GOT basic set] ใน [Utility main 

menu]

การแสดงผลสถานะแรงดันไฟฟ้าแบตเตอรี่

การแสดงผล สถานะ

Normal ปกติ

Low/None แรงดันไฟฟ้าตกหรือไม่ได้ติดตั้งแบตเตอรี่

หากแรงดันไฟฟ้าต�่า ให้เปลี่ยนแบตเตอรี่ทันที

GOT จะเก็บข้อมูลไว้เป็นเวลา 14 วัน หลังจากตรวจพบ

แบตเตอรี่ที่มีแรงดันไฟฟ้าต�่า อย่างไรก็ตาม หลังจากผ่านช่วง

เวลานี้แล้วจะไม่สามารถเก็บข้อมูลไว้ได้

4.4.3 การตรวจสอบแรงดันไฟฟ้าแบตเตอรี่
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4

(2) วิธีการตั้งค่าส�าหรับการแสดงผลบนหน้าจอการแจ้งเตือนของระบบ

1

1 สัมผัส [Utility call key]

2

2 สัมผัส [Display] บนหน้าจอ [GOT basic set] ใน [Utility main 

menu]

3

4

3 สัมผัส [Battery alarm display] และการตั้งค่าจะเปลี่ยน (ON 

⇔ OFF) 

ตั้งค่าเป็น [ON]

4 สัมผัสปุ่ม [OK] เพื่อเริ่มการท�างานของ GOT ใหม่ และใช้การ

ตั้งค่าที่ถูกเปลี่ยน

หากต้องการยกเลิกการตั้งค่า และกลับไปยังเมนูหลัก สัมผัส

ปุ่ม [Cancel]
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 ● การตรวจสอบบนหน้าจอการแจ้งเตือนของระบบ

เมื่อตรวจพบแรงดันไฟฟ้าแบตเตอรี่ตก หน้าต่างที่แสดงด้าน

ซ้ายจะแสดงผลให้เปลี่ยนแบตเตอรี่ทันที

GOT จะเก็บข้อมูลไว้เป็นเวลา 14 วัน หลังจากตรวจพบ

แบตเตอรี่ที่มีแรงดันไฟฟ้าต�่า อย่างไรก็ตาม หลังจากผ่านช่วง

เวลานี้แล้วจะไม่สามารถเก็บข้อมูลไว้ได้
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ภาคผนวก 1 รหัสผิดพลาดและรายการแจ้งเตือนของระบบ

(1) รหัสข้อผิดพลาดที่แสดงบน GOT

รหัสข้อผิดพลาด
แหล่งที่มาของข้อผิด

พลาด
ค�าอธิบาย

300 ถึง 399

GOT

รหัสผิดพลาดของฟังก์ชันยูนิดหลักของ GOT

400 ถึง 499 รหัสผิดพลาดของฟังก์ชันการสื่อสารของ GOT

500 ถึง 699 รหัสผิดพลาดของฟังก์ชันยูนิดหลักของ GOT

800 ถึง 999 เครือข่าย รหัสผิดพลาดของเครือข่าย

(2) รายการแจ้งเตือนของระบบ

รหัสข้อ

ผิดพลาด
ข้อความ Error แอคชัน

300
Project data contains unsupported 

objects.
ติดตั้งเวอร์ชันล่าสุดของ GT Designer3 และเขียนข้อมูลแพ็คเกจอีกครั้งไปยัง GOT

301
Project data contains unsupported 

functions.
ติดตั้งเวอร์ชันล่าสุดของ GT Designer3 และเขียนข้อมูลแพ็คเกจอีกครั้งไปยัง GOT

302
Project data contains unsupported 

settings.
ติดตั้งเวอร์ชันล่าสุดของ GT Designer3 และเขียนข้อมูลแพ็คเกจอีกครั้งไปยัง GOT

303
Set monitor points too large. 

Decrease setting points.

ลดจ�านวนของวัตถุจากหน้าจอที่แสดง ส�าหรับจ�านวนวัตถุสูงสุดส�าหรับ 1 หน้าจอ โปรดูเอกสาร

ต่อไปนี้

→ GT Designer3 (GOT2000) Screen Design Manual

305
Background loading of the system 

package failed.

ตรวจสอบว่าติดตั้งที่เก็บข้อมูล ซึ่งเก็บข้อมูลแพ็คเกจและข้อมูล project ของ GOT project แล้วและ

ข้อมูลไม่เสียหาย

306 No project data. Download screen data.
ไม่ได้ดาวน์โหลดข้อมูล project หรือข้อมูลหน้าจอไม่เพียงพอ

ดาวน์โหลดข้อมูล project หรือข้อมูลหน้าจอ

307 Monitor device not set ไม่ได้ตั้งค่าอุปกรณ์มอนิเตอร์ของวัตถุ

308 No comment data. Download comment.
ไม่มีไฟล์ข้อคิดเห็น

สร้างไฟล์ข้อคิดเห็นและดาวน์โหลดไปยัง GOT

309 Device reading error. Correct device.
เกิดข้อผิดพลาดขึ้นขณะก�าลังอ่านอุปกรณ์

เลือกอุปกรณ์ให้ถูกต้อง

310
Project data does not exist or out of 

range.

ไม่มีหน้าจอพื้นฐาน Base Screen/หน้าจอหน้าต่าง Window Screen ในข้อมูล project

หน้าจอพื้นฐาน Base Screen/หน้าจอหน้าต่าง Window Screen อยู่นอกช่วงที่อนุญาต ระบุหน้าจอ

พื้นฐาน/หน้าจอหน้าต่างที่มีอยู่

311
No. of alarm has exceeded upper limit. 

Delete restored alarm.

จ�านวนของประวัติการแจ้งเตือนที่สามารถสังเกตได้จากฟังก์ชันการแสดงประวัติการแจ้งเตือนเกิน

แต้มสูงสุด

ลบประวัติที่เก็บไว้เพื่อลบจ�านวนของประวัติการแจ้งเตือน

312
No. of sampling has exceeded upper 

limit. Delete collected data.

ความถี่ของการเก็บข้อมูลเกินขอบเขตของ “หน่วยความจ�าเก็บข้อมูล” และ “สะสม/เฉลี่ย” ถูกตั้งค่า

ในกราฟแบบกระจาย

•  อนุมัติการตั้งค่า “Clear trigger” ในกราฟแบบกระจาย

•  ตั้งค่า “Operation at frequency over time” เป็น “Initialize and Continue” ในกราฟแบบกระจาย

315 Device writing error. Correct device. ข้อผิดพลาดขณะที่ก�าลังเขียนลงในอุปกรณ์ ปรับอุปกรณ์ให้ถูกต้อง

ภาคผนวก
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รหัสข้อ

ผิดพลาด
ข้อความ Error แอคชัน

316
Cannot display or input operation value. 

Review expression.

คุณลักษณะโดยอ้อมของข้อคิดเห็น/หมายเลขพัสดุ ผลลัพธ์การปฏิบัติการของข้อมูลเกินช่วงที่

อุปกรณ์จะแสดง

ตรวจทานนิพจน์เชิงปฏิบัติการของข้อมูล เพื่อไม่ให้เกินช่วงที่ชนิดอุปกรณ์สามารถแสดง

317
Too high frequency of data collection.

Review conditions.

ข้อมูลของวัตถุ ที่ตั้งค่าให้ [Collect data only when trigger conditions are satisfied] ถูกเก็บบ่อยเกิน

ไป หรือจ�านวนของวัตถุเกินจ�านวนของวัตถุที่สามารถเก็บข้อมูลได้พร้อมกัน

• ตั้งค่าวงรอบที่นานขึ้นส�าหรับทริกเกอร์ที่เกิดขึ้นกับแต่ละวัตถุ

•  สร้างการตั้งค่าโดยที่ทริกเกอร์การแสดงผลของวัตถุ 257 ทริกเกอร์หรือมากกว่าที่ตั้งค่าให้ 

[Collect data only when trigger conditions are satisfied] ไม่เกิดขึ้นพร้อมกัน

320
Specified object does not exist or out of 

range.

ไม่มีไฟล์ชิ้นส่วน

สร้างไฟล์ชิ้นส่วนและดาวน์โหลดไปยัง GOT

322
Dedicated device is out of range.

Confirm device range.

จ�านวนอุปกรณ์ที่มอนิเตอร์อยู่นอกพื้นที่ที่อนุญาตของ PLC CPU เป้าหมาย

ตั้งค่าอุปกรณ์ภายในช่วงที่สามารถมอนิเตอร์โดย PLC CPU ที่มอนิเตอร์และการตั้งค่าพารามิเตอร์

326
Label data types do not match.

Confirm the label setting.

•  ชนิดข้อมูลของอุปกรณ์ที่ก�าหนดให้กับ Label ไม่ถูกต้อง 

ส�าหรับชนิดข้อมูลที่มีของ Label แบบ Global โปรดดูเอกสารต่อไปนี้ 
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•  ชนิดข้อมูลของอุปกรณ์วัตถุหรืออื่นๆ และ Label ที่ตั้งค่าในด้าน PLC ไม่สอดคล้องกัน 

ชนิดข้อมูลที่ถูกต้องของวัตถุหรืออื่นๆ ตาม Label นั้นๆ ถูกตั้งค่าในด้าน PLC

•  ค่าคงที่ถูกตั้งค่าส�าหรับ Label ในการตั้งค่าวัตถุไม่ใช้ Label ที่ตั้งค่าเป็นค่าคงที่

•  อุปกรณ์ 64 บิตถูกก�าหนดให้กับ Label 

ห้ามใช้ฉลาก 64 บิตในการตั้งค่าอุปกรณ์

327
Label names have not been resolved. 

Resolve label names again.

ตรวจสอบสถานะการเชื่อมต่อของ PLC และท�าการแก้ไขชื่อ Label อีกครั้ง

→ GT Designer3 (GOT2000) Screen Design Manual

328
Label setting error. Confirm the label 

setting.

•  Label ถูกตั้งค่าส�าหรับ PLC ซึ่งไม่รองรับ Label 

ปรับแก้ไขหมายเลขเครือข่ายและหมายเลขสถานี

•  ชื่อ Label ที่ระบุในข้อมูล project ไม่มีในด้าน PLC 

ตรวจสอบชื่อ Label ที่ระบุในข้อมูล project ที่มีอยู่ในด้าน PLC

•  GOT เข้าถึง Label ที่ไม่สามารเข้าถึงได้จากอุปกรณ์ภายนอก 

เปิดใช้งานการเข้าถึงจากอุปกรณ์ภายนอกในการตั้งค่า Label ในด้าน PLC

•  เมื่อ Label ของโครงสร้างมีสมาชิกที่อุปกรณ์ถูกก�าหนดค่าแบบแมนนวล GOT ล้มเหลวในการ

แก้ไขชื่อ Label 

ด�าเนินการปฏิบัติการโดยที่อุปกรณ์ถูกก�าหนดไปยังสมาชิกต่างๆ โดยอัตโนมัติ หรือตั้งค่าอุปกรณ์

ที่ถูกก�าหนดแบบ Manual โดยตรงให้เหมือนกับอุปกรณ์มอนิเตอร์

329
Station No. switching does not support 

labels.
ห้ามท�าการเปลี่ยนหมายเลขสถานะยังสถานีที่ใช้ Label

330
Insufficient memory media capacity.

Confirm M-card capacity.

มีที่ว่างในหน่วยความจ�าไม่เพียงพอ

ตรวจสอบที่ว่างที่มีของการ์ดหน่วยความจ�า ส�าหรับวิธีการตรวจสอบ โปรดดูเอกสารต่อไปนี้

→ GT Designer3 (GOT2000) Screen Design Manual

331
Memory card not installed or MCARD 

switched OFF.

ไม่ได้ติดตั้งการ์ดหน่วยความจ�าในไดร์ฟ หรือฝาปิดเอสดีการ์ดเปิดอยู่

• ติดตั้งการ์ดหน่วยความจ�าในอุปกรณ์ที่ระบุ

• ปิดฝาปิดเอสดีการ์ดเมื่อให้สามารถเข้าถึงเอสดีการ์ดได้

332 Memory media is not formatted.
ไม่ได้ฟอร์แมตการ์ดหน่วยความจ�า (เอสดีการ์ดภายใน) หรือฟอร์แมตไม่ถูกต้อง

ฟอร์แมตการ์ดหน่วยความจ�า
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รหัสข้อ

ผิดพลาด
ข้อความ Error แอคชัน

333
Unable to overwrite. Memory card is 

write-protected.

การ์ดหน่วยความจ�า (เอสดีการ์ดภายใน) มีการป้องกันการเขียน

ยกเลิกการป้องกันการเขียนของการ์ดหน่วยความจ�า

334
Memory media error. Replace memory 

media.

การ์ดหน่วยความจ�า (เอสดีการ์ดภายใน) มีความผิดพลาด

เปลี่ยนการ์ดหน่วยความจ�า

336
The target file size is too large to be 

accessed.

•  ตรวจสอบว่าขนาดของไฟล์ที่ GOT พยายามเข้าถึงใหญ่กว่า 2 GB หรือไม่

• ตรวจสอบว่าขนาดของไฟล์ภาพไม่เกิน 300 KB

337
File output failed. Confirm output file 

path.

มีโฟลเดอร์หรือไฟล์ต่อไปนี้ที่มีชื่อเดียวกันกับไฟล์ที่จะสร้างในเอสดีการ์ดหรือหน่วยความจ�า USB 

ปลายทางที่เก็บข้อมูล

• โฟลเดอร์เก็บข้อมูล

• ไฟล์ที่ป้องกันการเขียน

ลบโฟลเดอร์หรือไฟล์ด้านบน หรือเปลี่ยนชื่อของไฟล์ที่จะสร้าง

338
Modem is not connected correctly or the 

power is not turned on.

ไม่มีการตอบสนองต่อค�าสั่งการเริ่มต้นเนื่องจากไม่ได้เชื่อมต่อโมเด็มอย่างถูกต้อง หรือปิดเครื่องไว้

• ยืนยันการเชื่อมต่อโมเด็ม

• เปิด switch โมเด็ม

339
Failed to initialize the modem. Check 

initialization command.

ข้อผิดพลาดคืนกลับมาจากโมเด็มเนื่องจากค�าสั่งเริ่มต้นไม่ถูกต้อง

• ยืนยันค�าสั่งเริ่มต้นของโมเด็ม

340 Printer error or power failure

เครื่องพิมพ์ท�างานผิดพลาดหรือไม่ได้เปิด switch จ่ายไฟให้เครื่องพิมพ์

• ยืนยันเครื่องพิมพ์

• เปิด switch จ่ายไฟของเครื่องพิมพ์

342
External power is not supplied to 

external I/O unit.

เกิดข้อผิดพลาดที่ยูนิตอินเตอร์เฟซ I/O ภายนอก

•  หากไม่ได้จ่ายไฟภายนอก (24 V DC) ให้จ่ายไฟภายนอก

•  หากจ่ายไฟภายนอกแล้ว ให้เปลี่ยนยูนิตอินเตอร์เฟซ I/O ภายนอก

343
External I/O unit installation error.

Check if firmly installed.

ไม่ได้ติดตั้งยูนิตอินเตอร์เฟซ I/O ภายนอกอย่างถูกต้อง

ติดตั้งยูนิตอินเตอร์เฟซ I/O ภายนอกอย่างถูกต้อง

345 BCD/BIN conversion error Correct data

ค่าใดก็ตามที่ไม่สามารถแปลงเป็น BCD/BIN จะถูกแสดง/

• เปลี่ยนข้อมูลอุปกรณ์ที่จะแสดงเป็นค่า BCD

• ปรับแก้ไขค่าอินพุตให้เป็นจ�านวนเต็ม 4 หลัก

360
0 divisor division error. Confirm 

operation expression.

เกิดการหารด้วยศูนย์โดยนิพจน์ปฏิบัติการข้อมูล

ตรวจทานนิพจน์ปฏิบัติการข้อมูลโดยที่ตัวหารต้องไม่เป็น 0

361 Specified device No. is out of range. หมายเลขไฟล์ที่ป้อนอยู่นอกช่วง ตรวจสอบหมายเลขไฟล์ที่ป้อน และป้อนค่าที่ถูกต้อง (1 ถึง 9999)

362
Invalid device value in time action 

setting

เมื่อตัวควบคุมถูกควบคุมด้วยฟังก์ชันเวลาแอคชั่นของ GOT หมายเลขที่ตั้งค่าอยู่นอกช่วง หรือค่า

อุปกรณ์ที่ตั้งค่าตามการตั้งค่าปฏิบัติการอยู่นอกช่วงหรือไม่ถูกต้อง

ตั้งค่าที่ถูกต้อง

363
The file number exceeds the limitation. 

File output failed.
ลบไฟล์ที่มีจ�านวนไฟล์มากและไฟล์จ�านวนมากที่ไม่จ�าเป็น

370
Upper and lower limit value error.

Confirm value setting.

การตั้งค่าของค่าขีดจ�ากัดบนและล่างคือ [Upper limit < Lower limit]

ปรับแก้ไขการตั้งค่าให้เป็น “ขีดจ�ากัดบน ขีดจ�ากัดล่าง”

380
Insufficient USB drive capacity.

Confirm the drive capacity.

หน่วยความจ�าที่มีของไดร์ฟส่วนขยายไม่เพียงพอ

ยืนยันหน่วยความจ�าที่มีของไดร์ฟส่วนขยาย และเพิ่มหน่วยความจ�าเพิ่มเติม
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381
USB drive is not installed or in a 

removable state.
หากยังไม่ได้ท�าการติดตั้ง driver USB ให้ท�าการติดตั้ง

382 USB drive is not formatted.
ไม่ได้ฟอร์แมตไดร์ฟหรือฟอร์แมตเข้ากันไม่ได้กับ GOT

ฟอร์แมตไดร์ฟส่วนขยายใหม่

383
Unable to overwrite. USB drive is write-

protected

ไดร์ฟส่วนขยายป้องกันการเขียน

ยกเลิกการป้องกันการเขียนของไดร์ฟส่วนขยาย

384 USB drive error. Replace USB drive.
ไดร์ฟส่วนขยายท�างานผิดพลาด

เปลี่ยนไดร์ฟส่วนขยาย

401
An error response has been received 

from the connected device.

• ลดสาเหตุของข้อผิดพลาด CPU

•  ตรวจทานเงื่อนไขการปฏิบัติการของ CPU พารามิเตอร์ และอื่นๆ

402
Communication timeout. Confirm 

communication pathway or modules.

เกิดข้อผิดพลาด Time out ระหว่างการสื่อสาร

•  ยืนยันการถอดสายเคเบิล สถานะการติดตั้งของยูนิตการสื่อสาร และสถานะของ PLC 

หมายเลข Channel ไม่แสดงในรหัสผิดพลาด หรือข้อความ Error ในกรณีที่เกิดข้อผิดพลาดใน

ขณะที่ก�าลังใช้ฟังก์ชัน Multi channel 

โปรดดูคู่มือต่อไปนี้เพื่อระบุหมายเลข Channel ในข้อผิดพลาด 

→  GOT2000 Series Connection Manual for GT Works3 and a controller used (1.6 Checking 

for Normal Monitoring)

•  อาจเกิดข้อผิดพลาดนี้เมื่อโหลดของ PLC CPU หนักขึ้นในขณะที่ก�าลังเข้าถึงสถานีอื่นๆ ในกรณี

เช่นนี้ ให้ถ่ายโอนข้อมูลของสถานีอื่นไปยังสถานีโฮสต์ PLC CPU และเฝ้าระวังที่โฮสต์

• ใช้ค�าแนะน�าของ COM เมื่อการสแกน PLC ใช้เวลานาน

•  ตรวจสอบว่าเวอร์ชันของไดรฟ์เวอร์การสื่อสารรองรับตัวควบคุมหรือไม่ 

ส�าหรับวิธีการตรวจสอบเวอร์ชันของไดรฟ์เวอร์การสื่อสาร โปรดดูเอกสารต่อไปนี้ 

→ GT Designer3 (GOT2000) Screen Design Manual

403
SIO status error. Confirm communication 

pathway or modules.

ข้อผิดพลาดโอเวอร์รัน แพริตี้ หรือเฟลมมิ่งถูกสร้างเมื่อได้รับการสื่อสาร RS-422/RS-232

ยืนยันการถอดสายเคเบิล สถานะการติดตั้งของยูนิตการสื่อสาร สถานะของ PLC และความเร็วใน

การถ่ายโอนของที่ลิงก์คอมพิวเตอร์

หมายเลขแชนแนลไม่แสดงในรหัสผิดพลาด หรือข้อความ Error ดในกรณีที่เกิดข้อผิดพลาดใน

ขณะที่ก�าลังใช้ฟังก์ชัน Multi Channel

โปรดดูคู่มือต่อไปนี้เพื่อระบุหมายเลข Channel ในข้อผิดพลาด

→  GOT2000 Series Connection Manual for GT Works3 and a controller used (1.6 Checking for 

Normal Monitoring)

404
Response does not match communication 

request.
• ยืด Time out ของการสื่อสาร

406
Specified station access is out of range. 

Confirm station no.

•  หมายเลขสถานีอื่นนอกจากสถานีหลัก/สถานีในพื้นที่จะถูกระบุที่การเชื่อมต่อลิงก์ CC (ผ่าน G4)

•  มีการเข้าถึง PLC CPU อื่นที่ไม่ใช่ QCPU ยืนยันหมายเลขสถานีของข้อมูล project

407
Accessed other network. Change 

network setting.

•  ตรวจสอบการเข้าถึงเครื่อข่ายการท�างานต่างๆ ของ GOT เช่น MELSECNET/H 

,MELSECNET/10 (การสื่อสารระบบเครือข่ายของ PLC) หรือการเชื่่อมต่อกับตัวควบคุม CC 

link IE ให้ยื่นยันหมายเลขเครือข่ายของข้อมูล Project โดยการไม่ให้เข้าถึงเครื่อข่ายอื่นๆ

•  เมื่อก�าลังเฝ้าระวังเครือข่ายอื่น ก�าหนดค่า [Routing Information Setting] ของ GT Designer3 

หรือ [Routing Information Setting] ของ GX Developer ใหม่

•  เมื่อก�าลังใช้ GT15-75J71LP23-Z/GT15-75J71BR13-Z จะไม่สามารถเฝ้าระวังเครือข่ายอื่นได้ 

ยืนยันหมายเลขเครือข่ายของข้อมูล project โดยไม่ให้เข้าถึงเครือข่ายอื่น
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410
Cannot perform operation because of 

PLC run mode. Stop the PLC.

การปฏิบัติการซึ่งไม่สามารถท�าได้ระว่าง PLC CPU อยู่ในสถานะ Run ให้ด�าเนินการ

หยุดการท�างานของ PLC CPU

411
Memory cassette is write-protected.

Check the memory cassette.

หน่วยความจ�าที่ติดตั้งอยู่ใน PLC CPU เป็น EPROM หรือ E2PROM และอยู่ในสถานะป้องกันการ

เขียนทับ

ยืนยันว่าติดตั้งหน่วยความจ�าใน PLC CPU

412
Cannot read/write device protected by 

keyword. Remove keyword.

ค�าค�าสงวนถูกตั้งใน PLC CPU

ยกเลิกค�าสงวน

413 Unsupported CPU has been accessed.
• ตรวจสอบคู่มือล่าสุดเพื่อดูว่ารองรับ CPU หรือไม่

• เขียนข้อมูลแพ็คเกจที่สร้างด้วย GT Designer3 เวอร์ชันล่าสุด

420 E71 specification is ASCII.
[ASCII code] ถูกเลือกใน [Ethernet operations] ของการตั้งค่าด้าน PLC

เลือก [Binary code]

421 E71 is set as read-only. Clear setting.
ยูนิต Ethernet ที่ด้าน PLC ถูกตั้งค่าเป็นอ่านเท่านั้น

ตั้งค่ายูนิต Ethernet ที่ด้าน PLC ถูกตั้งค่าเป็นเปิดการเขียน

422
Not communicating between CPU and 

E71. Confirm CPU error.

ข้อผิดพลาดของการสื่อสารระหว่าง PLC CPU กับยูนิต Ethernet ไม่สามารถท�าได้

ตรวจสอบว่ามีข้อผิดพลาดหรือไม่โดยใช้ GX Developer (ยืนยันหน่วยความจ�าบัฟเฟอร์)

423
Insufficient network table information.

Add station no.

สถานีที่ตั้งค่าในข้อมูล project และหมายเลขสถานีที่ตั้งค่าในอุปกรณ์เปลี่ยนหมายเลขสถานี ไม่ตรง

กับการตั้งค่า Ethernet ของ GT Designer3

•  เพิ่มหมายเลขสถานีที่ตั้งค่าในข้อมูล project ไปยังการตั้งค่า Ethernet ของ GT Designer3

•  เมื่อใช้ฟังก์ชันการเปลี่ยนหมายเลขสถานี ให้ตรวจสอบข้อมูลของอุปกรณ์เปลี่ยนหมายเลขสถานี 

เมื่อหมายเลขสถานีที่ระบุในอุปกรณ์เปลี่ยนหมายเลขสถานีไม่ถูกตั้งค่าในการตั้งค่า Ethernet ให้

ท�าการเพิ่มหมายเลขสถานีไปยังการตั้งค่า Ethernet 

เมื่อไม่มีหมายเลขสถานีในระบบ เปลี่ยนข้อมูลของอุปกรณ์เปลี่ยนหมายเลขสถานี (ตั้งค่า

หมายเลขสถานีโดยให้เป็นเหมือนกับหมายเลขสถานีของการตั้งค่ายูนิต Ethernet ด้าน PLC ที่ตั้ง

ค่าไว้ในพารามิเตอร์ของ GX Developer)

424
Same sta. on GOT & project data. 

Review communication parameter.

หมายเลขสถานีที่ตั้งค่าใน utility ของ GOT เหมือนกับหมายเลขสถานีที่ตั้งค่าในการตั้งค่า Ethernet 

ของ GT Designer3 (หมายเลขสถานีของยูนิต Ethernet ด้าน PLC) หรือในข้อมูล project

ตรวจสอบเนื้อหาต่อไปนี้ โดยที่หมายเลขของแต่ละสถานีไม่ซ�้ากัน

• ตรวจสอบหมายเลขสถานีของ GOT ใน utility ของ GOT

• ตรวจสอบหมายเลขสถานีที่ตั้งค่าในข้อมูล project

•  ตรวจสอบหมายเลขสถานีที่ตั้งค่าในการตั้งค่า Ethernet (ตั้งค่าหมายเลขสถานีโดยให้เป็นเหมือน

กับหมายเลขสถานีของการตั้งค่ายูนิต Ethernet ด้าน PLC ในการตั้งค่าพารามิเตอร์ของ GX 

Developer)

•  เมื่อใช้ฟังก์ชันการเปลี่ยนหมายเลขสถานี ให้ตรวจสอบข้อมูลของอุปกรณ์เปลี่ยนหมายเลขสถานี

425
A duplicate IP address has been detected. 

Confirm the setting.

GOT มีที่อยู่ IP เดียวกันกับอุปกรณ์อื่น

เปลี่ยนที่อยู่ IP ของ GOT หรืออุปกรณ์

430
Wireless LAN unit is not mounted or a 

hardware error occurred.

ไม่ได้ติดตั้งยูนิตการสื่อสาร Wireless LAN ที่ด้านอินเตอร์เฟซ

ตรวจสอบว่าติดตั้งยูนิตอย่างถูกต้อง

431 Connectable access point is not found. ตรวจสอบการตั้งค่าส�าหรับจุดเข้าถึงที่เชื่อมต่อได้ และการตั้งค่าการเชื่อมต่อ Wireless LAN

432
Wireless LAN connection settings are 

not specified.

หลังจากการก�าหนดค่าการตั้งค่าการเชื่อมต่อ Wireless LAN เปิดใช้งานฟังก์ชันการเชื่อมต่อ 

Wireless LAN

→ GT Designer3 (GOT2000) Screen Design Manual
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433 Failed to authenticate the access point. ตรวจสอบว่าวิธีการให้สิทธิ์ที่ระบุในการตั้งค่าการเชื่อมต่อ Wireless LAN เหมือนกับด้านจุดเข้าถึง

434
GOT hardware version not supported by 

wireless LAN connection

ใช้ GOT กับฮาร์ดแวร์เวอร์ชัน B หรือรุ่นที่ใหม่กว่า

ส�าหรับวิธีการตรวจสอบเวอร์ชันฮาร์ดแวร์ โปรดดูเอกสารต่อไปนี้

→ GOT2000 Series User’s Manual (Hardware)

440 The label information has been updated.
การแก้ปัญหาชื่อของ Label จะด�าเนินการโดยอัตโนมัติ

รอการด�าเนินการให้เสร็จ

441
The specified CPU is updating the label 

information.

ข้อมูล Global Label ของ CPU ที่ระบุจะถูกอัพเดต

รอการด�าเนินการให้เสร็จ

442

Resolving the label information.

Do not turn off the power during the 

process.

ก�าลังด�าเนินการแก้ปัญหาชื่อ Label

รอการด�าเนินการให้เสร็จ

448
PLC cannot handle as requested.

Correct devices.

มีการระบุอุปกรณ์ File Register นอกช่วงของ PLC CPU และหน่วยความจ�าบัฟเฟอร์

ปรับแก้ไขอุปกรณ์เฝ้าระวังโดยการตั้งค่า File Register ของ PLC CPU

449
Dedicated device is out of range.

Confirm device range.
ตั้งค่าที่อยู่ส�าหรับยูนิตฟังก์ชันพิเศษในช่วงที่มีของการเฝ้าระวัง GOT

450
Path has changed or timeout occurred in 

redundant system.

พาธถูกเปลี่ยนหรือเกิดเวลาหมดในระบบแบบซ�้าซ้อน

• ตรวจสอบ PLC CPU เพื่อให้ทราบว่าพาธถูกเปลี่ยน

•  ตรวจสอบสถานะการเชื่อมต่อของสายเคเบิล สถานะการติดตั้งยูนิตสื่อสาร และสถานะ PLC 

CPU

•  ข้อผิดพลาดนี้สามารถเกิดเมื่อโหลดของ PLC CPU มากขึ้นเมื่อมีการเข้าถึงสถานีอื่น ในกรณีเช่น

นี้ ให้ถ่ายโอนข้อมูลของสถานีอื่นไปยังสถานีโฮสต์ PLC CPU และเฝ้าระวังที่โฮสต์

•  ด�าเนินการหนึ่งข้อต่อไปนี้หากเวลาในการสแกน PLC นาน: ค�าแนะน�า COM/ส่วนขยายของการ

ประมวลผล END/การตั้งค่าจ�านวนของเวลาประมวลผลส�าหรับข้อมูลทั่วไป/การประมวลผลเป็น

ชุดส�าหรับอัพเดตข้อมูล

451
Q redundant system settings and current 

config. Do not match.
เปลี่ยนการตั้งค่า Q ตามระบบ CPU ของระบบแบบ redundant

460 Communication unit error
• รีเซ็ตเครื่อง GOT

• เปลี่ยนยูนิต

461
Communication error occurred between 

option units and the GOT.

ตรวจสอบคู่มือต่อไปนี้ส�าหรับคุณลักษณะการต้านทานต่อการสั่นและวิธีการติดตั้งยูนิตตัวเลือก

หลังจากนั้นรีเซ็ตแหล่งจ่ายไฟของ GOT

→ GOT2000 Series User’s Manual (Hardware)

470
No routing params. Communication not 

established with specified sta.
ตั้งค่าพารามิเตอร์ routing

471
No IP address info. (Ethernet table) of 

connection destination.
ตั้งค่าข้อมูลเครือข่ายเกี่ยวกับปลายทางส�าหรับ [Ethernet setting]

480
Communication channel not set. Set 

channel number on Utility.

ไม่ได้ตั้งค่า Channel (CH หมายเลข 1 ถึง 4) ส�าหรับการสื่อสารกับตัวควบคุม

•  หลังจากการตั้งค่าการตั้งค่าการสื่อสารบน GT Designer3 ดาวน์โหลดไปยัง GOT

•  เปลี่ยนการก�าหนดแชนแนลในการตั้งค่าการสื่อสารบน utility

481
Communication unit not mounted to the 

slot of active channel.

interface ที่ channel (CH หมายเลข 1 ถึง 4) ถูกตั้งค่าไม่ได้ติดตั้งยูนิตการสื่อสาร

•  ติดตั้งยูนิตการสื่อสารไปยัง interface ที่ตั้งค่า channel (CH หมายเลข 1 ถึง 4)

•  เปลี่ยนการก�าหนดของ channel (CH หมายเลข 1 ถึง 4) ในการตั้งค่าการสื่อสาร
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482
Too many same units are mounted.

Confirm the no of units.

ยูนิตที่ติดตั้งบน GOT เกินจ�านวนสูงสุดของยูนิตที่สามารถติดตั้งได้

ตรวจสอบจ�านวนของยูนิต และถอดยูนิตที่ไม่จ�าเป็นออก

483
Simultaneous mounting of the units are 

not allowed.

ไม่สามารถติดตั้งยูนิตตั้งแต่สองยูนิตขึ้นไปพร้อมกันบน GOT

ตรวจสอบยูนิตที่ติดตั้ง และถอดยูนิตที่ไม่จ�าเป็นออก

484
Unit mounted incorrectly. Move the unit 

to correct position.

ไม่ได้ติดตั้งยูนิตบน GOT ในต�าแหน่งที่ถูกต้อง

ยืนยันต�าแหน่งการติดตั้งของยูนิต

485
Too many units mounted on GOT.

Reduce units.

ยูนิตที่ติดตั้งบน GOT เกินจ�านวนสูงสุดของยูนิตที่สามารถติดตั้งได้

ตรวจสอบจ�านวนของยูนิต และถอดยูนิตที่ไม่จ�าเป็นออก

486
Communication unit not corresponded to 

set communication driver.

ไดรฟ์เวอร์สื่อสารที่ตั้งค่าไว้ในการตั้งค่าการสื่อสารเข้ากันไม่ได้กับยูนิตการสื่อสารที่ติดตั้งบน GOT

•  ตรวจสอบว่าไดรฟ์เวอร์สื่อสารที่ตั้งค่าไว้ในการตั้งค่าการสื่อสารถูกต้องหรือไม่

•  ตรวจสอบว่าติดตั้งยูนิตการสื่อสารที่ไม่ถูกต้องบน GOT หรือไม่

487
Please turn on the PLC and the GOT 

again.
เปิด PLC และ GOT อีกครั้ง

488
Too many units mounted on GOT.

Reduce units.

ยูนิตที่ติดตั้งบน GOT เกินจ�านวนสูงสุดของยูนิตที่สามารถติดตั้งได้ ตรวจสอบจ�านวนของยูนิต 

และถอดยูนิตที่ไม่จ�าเป็นออก

489
Inactive channel has been selected at 

Communication Settings.

หมายเลข Channel ที่ไม่แอคทีฟถูกตั้งค่าในข้อมูล project

•  ตรวจสอบว่ามีการตั้งค่าหมายเลข Channel ที่ไม่จ�าเป็นในข้อมูล project หรือไม่

•  ตรวจสอบว่าหมายเลข Channel ที่ตั้งค่าไว้ในข้อมูล project ถูกตั้งค่าในการตั้งค่าการสื่อสารหรือ

ไม่

492
Unusable communication units are 

mounted.

ติดตั้งยูนิตที่ไม่เสถียรส�าหรับ GOT

ถอดยูนิตที่ไม่เสถียรออก

493
Installation of extension units may be 

inappropriate.
ตรวจสอบว่าติดตั้งยูนิตส่วนขยายอย่างปลอดภัยบน GOT หรือไม่

497 Failed to start communication driver(s). ติดตั้งไดรฟ์เวอร์สื่อสารอีกครั้ง

500 Warning! Built-in battery voltage is low.
แรงดันไฟฟ้าแบตเตอรี่ของ GOT ลดลง

เปลี่ยนแบตเตอรี่ภายในของ GOT

506 Warning! Backlight needs replacement.

GS เฉพาะด้านได้รับการแจ้งว่า เวลาเปิดไฟแบคไลท์เพิ่มเติมถึงเวลาที่ตั้งไว้หรือมากกว่า

โปรดปรึกษาศูนย์บริการหรือตัวแทน Mitsubishi ในพื้นที่ของคุณ

สามารถคืนข้อมูล GOT โดยการเรียกใช้ฟังก์ชันรีเซ็ตเวลาเพิ่มเติม สามารถคืนข้อมูล GOT โดยการ

ปิดสัญญาณแจ้งเตือนแบบ Manual ได้เช่นกัน ในกรณีเช่นนี้ ให้ปิดหลังการตั้งค่าที่มากกว่าเวลาเพิ่ม

เติม

510 Clock data input out of range

ข้อมูลนาฬิกาเป็นข้อมูลอินพุตที่อยู่นอกช่วงของอินพุตที่เปิดใช้งาน

ในกรณีนี้ ไม่สามารถยอมรับค่าอินพุตได้

ยืนยันช่วงอินพุตที่จ�าอินพุตเป็นข้อมูลนาฬิกา และป้อนค่าที่เหมาะสมอีกครั้ง

522
Unnecessary file deleted to create new 

file.

ไฟล์เก่าของเนื้อหาที่แตกต่างออกไปถูกลบและสร้างไฟล์ใหม่

สังเกตว่าไฟล์เก่าถูกลบและไฟล์ใหม่ถูกสร้างหากมีไฟล์ที่มีชื่อเดียวกันซึ่งมีเนื้อหาที่ต่างกันอยู่ใน

ขณะที่ท�าการสร้างไฟล์

523
The read alarm log file has a different 

number of alarm points.

เมื่อมีการเปลี่ยนแปลงการตั้งค่าการแจ้งเตือนรวมถึงจ�านวนการแจ้งเตือน บันทึกการแจ้งเตือนก่อน

หน้านี้จะถูกเปลี่ยนรูปแบบให้เป็นไปตามการตั้งค่าใหม่ด้วย

ลบไฟล์บันทึกการแจ้งเตือนตามความจ�าเป็น
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525
Unable to read/write alarm log files 

under different projects.

ไม่สามารถอ่านไฟล์บันทึกการแจ้งเตือนที่บันทึกโดย project ที่แตกต่างกัน

ยืนยันไฟล์บันทึกการแจ้งเตือนและที่ส�าหรับเก็บไฟล์บันทึกการแจ้งเตือน

526 File conversion failed.
ไม่มีไฟล์ที่ระบุส�าหรับการแปลงไฟล์

ตรวจสอบการตั้งค่าส�าหรับการการแปลงไฟล์

527 Insufficient SRAM capacity.
ความจุ SRAM ไม่เพียงพอ

ยืนยันว่ามีหน่วยความจ�าที่เพียงพอในพื้น SRAM

528
Error in SRAM.

Failed to write data.

ข้อผิดพลาดอาจเกิดจากความล้มเหลวของ GOT

ติดต่อตัวแทน Mitsubishi ในพื้นที่ของคุณ

529
Data error in SRAM. Check the battery 

life.

ข้อมูลใน SRAM เกิดความผิดพลาด เนื่องจากแรงดันไฟฟ้าแบตเตอรี่ต�่า เป็นต้น

ตรวจสอบสถานะแบตเตอรี่

532
Cannot access the files.

Check the memory card.

ตรวจสอบชื่อไฟล์

ชื่อไฟล์มีอักขระที่ไม่ถูกต้อง

ส�าหรับชนิดของอักขระและจ�านวนของอักขระส�าหรับชื่อไฟล์ โปรดดูเอกสารต่อไปนี้

→ GT Designer3 (GOT2000) Screen Design Manual

533
Cannot access Files. Check the memory 

card.

•  ใส่เอสดีการ์ดหรือการ์ดหน่วยความจ�า

•  ปิดฝาปิดเอสดีการ์ดเพื่อให้สามารถเข้าถึงเอสดีการ์ดได้

•  หากเอสดีการ์ดหรือหน่วยความจ�า USB มีไฟล์ที่ไม่จ�าเป็น ให้ลบไฟล์

535 Cannot open image file. ตรวจสอบว่าไฟล์เป้าหมายถูกเก็บไว้ในเอสดีการ์ดหรือหน่วยความจ�า USB

536 Image file error or invalid file format.
•  ยืนยันว่าไฟล์ภาพในเอสดีการ์ดหรือหน่วยความจ�า USB ปกติ

• ยืนยันว่าเก็บข้อมูลไฟล์ภาพด้วยรูปแบบที่ไม่ถูกต้องหรือไม่

562
Install the font appropriate for the 

specified system language.

ไม่มีการติดตั้งรูปแบบอักษรที่เหมาะสมส�าหรับภาษาของระบบ

ติดตั้งรูปแบบอักษรที่เหมาะสม

565
Files for the extended system application 

are missing.

ไฟล์ส�าหรับการใช้งานฟังก์ชั่นส่วนขยายจะหายไป คุณจะไม่สามารถเรียกใช้งานไฟล์ได้อีก

ติดตั้งฟังก์ชั่นส่วนขยายให้กับระบบ

571
Capacity shortage of user memory 

(RAM)

ไม่มีพื้นที่ว่าง/ที่ว่างในหน่วยความจ�า

ฟอร์แมต หรือลบข้อมูลที่ไม่จ�าเป็นในหน่วยความจ�าไดร์ฟDเพื่อให้มีพื้นที่ว่างมากขึ้น

577 Newly readable records do not exist.
พื้นที่ส�าหรับการอ่านข้อมูลที่บันทึกไว้ไม่เพียงพอ

ลบข้อมูลที่ไม่จ�าเป็นออก

578
The specified record name is invalid.

Check the record name.
ไม่มีชื่อของข้อมูลที่บันทึกไว้

579
Recipe is in process. Cannot operate the 

recipe file.
มีสูตรอื่นก�าลังประมวลผลอยู่ในกระบวนการ

580
Selected recipe setting is not the recipe 

file operation target.
การตั้งค่าสูตรที่ระบุไม่มีในไฟล์เป้าหมาย

581 Abnormal Advanced recipe file
ไฟล์สูตรเนื้อหาไม่ถูกต้องไม่สามารถเรียกใช้งานได้ ลบไฟล์สูตรจากเอสดีการ์ดหรือหน่วยความ

จ�า USB

582 Cannot generate Advanced recipe file.

ไม่สามารถสร้างไฟล์สูตร ยืนยันรายการต่อไปนี้ และท�าการประมวลผลสูตรอีกครั้ง

• ยืนยันว่าติดตั้งเอสดีการ์ดหรือหน่วยความจ�า USB แล้ว

• ปิดฝาปิดเอสดีการ์ดเมื่อให้สามารถเข้าถึงเอสดีการ์ดได้

• ยืนยันพื้นที่ว่างของหน่วยความจ�า
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583
Unable to save device value to Advanced 

recipe file.

ไม่สามารถบันทึกค่าไปยังไฟล์สูตร

• ยืนยันการป้องกันการเขียนของเอสดีการ์ดหรือหน่วยความจ�า USB

• ยืนยันว่าคุณลักษณะของไฟล์เป็นอ่านอย่างเดียว

584 Advance recipe file save error
เกิดข้อผิดพลาดระหว่างการเขียนไฟล์สูตร ห้ามดึงเอสดีการ์ดหรือหน่วยความจ�า USB ออกในขณะ

ที่สูตรท�างานอยู่

585 Advanced recipe file upload error
เกิดข้อผิดพลาดระหว่างการอ่านไฟล์สูตร

ห้ามดึงเอสดีการ์ดหรือหน่วยความจ�า USB ออกในขณะที่สูตรท�างานอยู่

586
Specified Advanced recipe number does 

not exist.

ก�าลังจะเรียกใช้สูตรที่ไม่มีหมายเลข

เรียกใช้สูตรที่มีหมายเลขอยู่แล้ว

587 Specified record number does not exist.
ก�าลังจะเรียกใช้ข้อมูลชั้นสูงที่ไม่มีหมายเลข

เรียกใช้ข้อมูลที่มีหมายเลขอยู่แล้ว

588
Cannot save recipe data to read only 

record.
ไม่สามารถบันทึกข้อมูลได้ ท�าการตั้งค่าสูตรให้สามารถแก้ไขข้อมูลได้ 

589
Recipe device save error. Recipe file 

does not exist.
การบันทึกสูตรผิดพลาด ไม่สามารถบันทึกสูตรไปยังไฟล์ได้

590
Recipe device upload error. Recipe 

device value does not exist.
การอัพโหลดสูตรผิดพลาด ไม่สามารถอัพโหลดสูตรจากไฟล์ได้

591
Advanced Recipe error. Check recipe 

data.
การตั้งค่าไม่ถูกต้อง ตรวจสอบการตั้งค่าใหม่

592
The extension specified to the recipe file 

is invalid.

ตรวจสอบว่าชื่อไฟล์เหมาะสม

ชื่อไฟล์มีอักขระที่ไม่ถูกต้อง ส�าหรับรายละเอียด โปรดดูเอกสารต่อไปนี้

→ GT Designer3 (GOT2000) Screen Design Manual

593

The setting of G1P file of the original 

diversion is different from the project 

data.

นามสกุลของไฟล์ มีความแตกต่างกับนามสกุลของไฟล์ GOT2000

595 Logging file error. การบันทึกไฟลไม่ถูกต้อง ตรวจสอบข้อมูลที่จะท�าการบันทึก

596
Logging setting does not exist or setting 

value error.
การตั้งค่าไม่ถูกต้องตรวจสอบการตั้งค่า

597 The specified logging ID does not exist. ข้อมูลที่จะท�าการบันทึก ไม่สามารถท�าการบันทึกไปยัง ID ปลายทางได้ ตรวจสอบการตั้งค่า

598
The specified logging setting is 

incompatible.
การตั้งค่ากับข้อมูลที่จะท�าการบันทึกไม่ถูกต้อง ขัดแย้งกัน ตรวจสอบการตั้งค่า

601 Printer unit error.

ติดตั้งยูนิตเครื่องพิมพ์ไม่ถูกต้อง หน่วยความจ�าแฟลชภายในของยูนิตเครื่องพิมพ์เสียหาย หรือเกิน

อายุการใช้งานที่รับประกัน

ตรวจสอบว่าติดตั้งยูนิตเครื่องพิมพ์ถูกต้อง

เมื่อติดตั้งยูนิตเครื่องพิมพ์ถูกต้อง หากอุปกรณ์ภายในเสียหายหรือเกินอายุการใช้งานที่รับประกัน 

แนะน�าให้เปลี่ยนยูนิตเครื่องพิมพ์

602 Video/RGB unit not mounted
•  ตรวจสอบว่าอินพุตวิดีโอ/RGB ถูกติดตั้งแล้ว

•  ตรวจสอบว่า อินพุตวิดีโอ/RGB เป็นไฟล์ที่ GOT รองรับ

603 External I/O unit error ตรวจสอบว่าติดตั้งยูนิต I/O อย่างถูกต้อง

604 Sound output unit error ตรวจสอบว่าติดตั้งยูนิตเอาท์พุตเสียงอย่างถูกต้อง
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605 USB device I/F error
ข้อผิดพลาดอาจเกิดจากความล้มเหลวใน GOT

ติดต่อตัวแทน Mitsubishi ในพื้นที่ของคุณ

606
Multimedia processing unit is not 

mounted.

ติดตั้งยูนิตมัลติมีเดียไม่ถูกต้อง

ตรวจสอบว่าติดตั้งยูนิตมัลติมีเดียถูกต้อง

607
Video · RGB input object has too many. 

Please reduce the number of settings.
การแสดงผลของอินพุตวิดีโอ/RGB มีจ�านวนมากเกินไป ลดจ�านวนของอุปกรณ์ให้น้อยลง 

608

Hierarchical relationship of video · RGB 

input object can not be represented 

correctly.

ตรวจสอบให้แน่ใจว่าการแสดงผลไฟล์วิดีโอ/RGB ไม่ทับซ้อนกัน 

610 Insufficient memory capacity.
ความจุหน่วยความจ�าไม่เพียงพอ

ส�ารองหน่วนความจ�าและลบไฟล์ที่ไม่จ�าเป็น

611 Improper job files. Confirm job setting. เนื้อหาของไฟล์ไม่ตรงกับการตั้งค่า ตรวจสอบว่ามีข้อผิดพลาดในการตั้งค่าหรือไม่

612
Cannot access Logging Files. Check the 

memory card.

•  ใส่เอสดีการ์ดหรือการ์ดหน่วยความจ�า USB

•  ปิดฝาเมื่อให้สามารถเข้าถึงเอสดีการ์ดได้

• ลบไฟล์ที่ไม่จ�าเป็นในเอสดีการ์ดหรือหน่วยความจ�า USB

613 Error in writing logfile

•  ใส่เอสดีการ์ดหรือการ์ดหน่วยความจ�า USB

•  ปิดฝาเมื่อให้สามารถเข้าถึงเอสดีการ์ดได้

•  ตรวจสอบว่าสามารถเขียนเอสดีการ์ดหรือหน่วยความจ�า USB

614 Error in reading logfile

•  ใส่เอสดีการ์ดหรือการ์ดหน่วยความจ�า USB

•  ปิดฝาเมื่อให้สามารถเข้าถึงเอสดีการ์ดได้

•  ตรวจสอบว่าสามารถอ่านเอสดีการ์ดหรือหน่วยความจ�า USB ได้หรือไม่

615
Cannot connect to MES Server.

Check the Server.

•  เซิร์ฟเวอร์ท�างานผิดปกติหรือการตั้งค่าการเชื่อมต่อไม่ถูกต้อง

•  ตรวจสอบเงื่อนไขการท�างานของเซิร์ฟเวอร์

•  ตรวจสอบเครือข่ายที่เชื่อมต่อไปยังเซิร์ฟเวอร์

616
Cannot connect to SNTP Server.

Check the Server.

•  การตั้งค่าเซิร์ฟเวอร์ SNTP ผิดพลาด หรือเครือข่ายในการเข้าถึง SNTP ไม่ถูกต้อง

•  ตรวจสอบเงื่อนไขการท�างานของเซิร์ฟเวอร์ STNP

•  ตรวจสอบเครือข่ายที่เชื่อมต่อไปยังเซิร์ฟเวอร์ STNP

620 Trial connection has started.
หมายเลขสิทธิในการเข้าถึงฟังก์ชันมือถือของ GOT ถูกยกเลิก หรือไม่สามารถลงทะเบียนได้

เพื่อใช้ฟังก์ชั่นมือถือของ GOT ในเวอร์ชันเต็ม โปรดลงทะเบียนหมายเลขสิทธิ์การใช้งาน

630 Failed to save a video file.
ตรวจสอบพื้นที่ว่างของ CF การ์ด สถานะการติดตั้ง การยกเลิกการป้องกันการเขียน สถานะ

ฟอร์แมต และจ�านวนของไฟล์ที่บันทึก

631 Failed to save a video file on network.

ตรวจสอบสถานะการเปิดใช้งานของซอฟต์แวร์ การตั้งค่าของฟังก์ชัน Ethernet FTP ของ GOT 

การตั้งค่าเครือข่ายของ GOT ไฟล์เซิร์ฟเวอร์ และพื้นที่ว่างองเอสดีการ์ดที่ติดตั้งในยูนิตหลักของ 

GOT

632
Error detected during multimedia 

processing.
พบข้อผิดพลาดระหว่างการประมวลผลมัลติมีเดีย

633
The version of the unit software is not 

the latest.
ติดตั้งซอฟต์แวร์ยูนิตที่โดยใช้ utility ของ GOT
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ผิดพลาด
ข้อความ Error แอคชัน

634

No space remaining in the multimedia 

CF card. Terminating long time 

recording.

เปลี่ยน CF การ์ด ที่ติดตั้งบนยูนิตมัลติมีเดีย หรือลบไฟล์ที่ไม่จ�าเป็น

640
An error occurred in a FTP client 

process.

ก�าหนดค่าการตั้งค่า GOT (ไคลเอนต์ FTP) ใหม่

ตรวจสอบสถานะการท�างานและเครือข่ายของเซิร์ฟเวอร์ FTP

ส�าหรับรายละเอียดข้อผิดพลาด ตรวจสอบที่รีจิสเตอร์พิเศษของ GOT เบอร์ GS989  (การแจ้งข้อ

ผิดพลาดการสื่อสาร FTP)

→ GT Designer3 (GOT2000) Screen Design Manual

641
The license key has not been registered. 

Confirm your license.

ไม่มีการลงทะเบียนหมายเลขสิทธิการใช้งานส�าหรับฟังก์ชันเซิร์ฟเวอร์ VNC ฟังก์ชันการสื่อสาร

ของคอมพิวเตอร์ส่วนบุคคล (Ethernet) ฟังก์ชันอินเตอร์เฟซของ MES หรือฟังก์ชันมือถือ GOT

650
The operator management information 

file is invalid.
เตรียมไฟล์ข้อมูลการจัดการการน�าเข้าไฟล์ หรือเก็บไฟล์ข้อมูล

651
Cannot access the operator management 

information file.
ตรวจสอบว่าสามารถเข้าถึงไดร์ฟปลายทางที่เก็บไฟล์ที่ระบุได้โดย GOT

660
Failed to obtain op. authority. Server 

does not respond.

ตรวจสอบให้แน่ใจว่าเชื่อมต่อและ GOT เริ่มท�างานแล้ว

ตรวจสอบให้แน่ใจว่าฟังก์ชันโต้ตอบเครือข่ายของ GOT ถูกเปิดใช้งานแล้ว

670
Current alarms exceeded the max no. that 

can be procd. at a time.

เกิดการแจ้งเตือนของระบบตั้งแต่หนึ่งร้อยการแจ้งเตือนพร้อมกัน

ลดสาเหตุของการแจ้งเตือนและตรวจสอบการแจ้งเตือน

697
Package writing of the old version is not 

allowed.
ไม่สามารถเขียนแพคเกจของเวอร์ชั่นเก่าได้

698 Insufficient CoreOS version. ติดตั้งเวอร์ชันล่าสุดของ CoreOS

699 Insufficient BootOS version. ติดตั้งเวอร์ชันล่าสุดของ BootOS

800 Abnormal module status
โปรดดูค�าอธิบายของ SB0020 บนคู่มือที่เกี่ยวข้อง

ส�าหรับ CC-Link IE Field โปรดดูคู่มือของเครือข่าย MELSEC-Q CC-Link IE Field

801 Abnormal baton passing status โปรดดูค�าอธิบายของ SB0047 บนคู่มือที่เกี่ยวข้อง

802 Abnormal cyclic transmission status โปรดดูค�าอธิบายของ SB0049 บนคู่มือที่เกี่ยวข้อง

803 Transient error โปรดดูค�าอธิบายของ SB00EE บนคู่มือที่เกี่ยวข้อง

804
The cable on the IN side is disconnected 

or is not connected.
โปรดดูค�าอธิบายของ SB0067 บนคู่มือที่เกี่ยวข้อง

805
The cable on the OUT side is 

disconnected or is not connected.
โปรดดูค�าอธิบายของ SB0068 บนคู่มือที่เกี่ยวข้อง

840 PROFIBUS master is not started. เปิด PROFIBUS หลัก

841
I/O setting of the PROFIBUS master and 

slaves do not match.

•  ใช้ไฟล์ GSD การก�าหนดค่าที่ MITSUBISHI ให้ไว้ (ห้ามการแก้ไข)

• ปรับการตั้งค่าที่เกี่ยวข้องให้ถูกต้อง และปิดระบบ จากนั้นเปิดระบบ GOT

850 CC-Link switch setting error

• ตรวจสอบว่าการตั้งค่า switch ไม่มีข้อผิดพลาด

•  ตรวจสอบรหัสข้อผิดพลาดที่เก็บไว้ใน SW006A

• โปรดดูค�าอธิบายของ SB006A บนคู่มือที่เกี่ยวข้อง



ภาคผนวก 1-12

รหัสข้อ

ผิดพลาด
ข้อความ Error แอคชัน

851 Abnormal cyclic transmission status

•  ตรวจสอบว่ามีการต่อต่อกับตัวต้านทานเทอร์มิเนต

•  ตรวจสอบรหัสผิดพลาด PLC CPU

•  ตรวจสอบพารามิเตอร์ PLC CPU

•  ตรวจสอบสถานะข้อผิดพลาด

•  โปรดดูค�าอธิบายของ SB006E บนคู่มือที่เกี่ยวข้อง

852 Abnormal host line status
•  ตรวจสอบว่าเชื่อมต่อสายเคเบิลอย่างถูกต้อง

•  โปรดดูค�าอธิบายของ SB0090 บนคู่มือที่เกี่ยวข้อง

853 Transient error
•  ตรวจสอบสถานะข้อผิดพลาดส�าหรับแต่ละสถานีที่เก็บไว้ใน SW0094 ถึง SW0097

•  โปรดดูค�าอธิบายของ SB0094

860 Off line or the network power is off.

• ตรวจสอบตัวแสดงสถานะ LED ของสถานะโมดูล

• เปิดเครือข่าย

• ตรวจสอบว่าเชื่อมต่อสายเคเบิลอย่างถูกต้อง

•  ตั้งค่าความเร็วในการสื่อสารของ GOT กับอุปกรณ์หลัก

861 No connections are established.
• ตรวจสอบการตั้งค่าของอุปกรณ์

• เปิดอุปกรณ์หลัก

862 Critical link error
มีข้อผิดพลาดการใช้งานการสื่อสารของเครือข่าย (MAC ID ซ�า้กัน หรือตรวจพบการปิดบัส) ตรวจ

สอบตัวควบคุม

863 Incomplete configuration
ไม่ได้ตั้งค่าตัวควบคุม หรือการตั้งค่าไม่ถูกต้อง

ตรวจสอบการตั้งค่าตัวควบคุม

864 Unrecoverable fault(s) ตัวควบคุมมีข้อผิดพลาดที่ไม่สามารถแก้ไขได้

865 Recoverable fault(s) ข้อผิดพลาดได้รับการแก้ไขโดยอัตโนมัติ
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ติดตั้ง GOT โดยพิจารณาถึงขนาดภายในของแผงควบคุม และพื้นที่ต้องห้ามส�าหรับการติดตั้ง

โดยขึ้นอยู่กับชนิดของสายเคเบิลเชื่อมต่อไปยัง GOT อาจต้องการระยะทางที่มากกว่าที่บรรยายไว้

ติดตั้ง GOT โดยพิจารณาถึงขนาดภายในของคอนเนคเตอร์ และรัศมีการโค้งของสายเคเบิล

2 ขนาด panel

 ● GT2715-X

ขนาด panel ส�าหรับการติดตั้งบนแผงควบคุม โดยมีขนาดตามที่แสดงด้านล่าง

A

B

CC

C
C

A

B

C
C

CC

แนวนอน แนวดิ�ง

หน่วย: มม.

รุ่น A B C ความหนาของ panel

GT2715-X 383.5
(+2, 0)

282.5
(+2, 0) 10 หรือมากกว่า 1.6 ถึง 4

ขนาด C แสดงการวัดส�าหรับการติดตั้งบนแผงควบคุม

ภาคผนวก 2 การติดตั้งและการถอดประกอบ

1 ข้อควรระวังเบื้องต้น
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 ● GT2712-S, GT2710-S, GT2710-V, GT2708-S, GT2708-V, GT2705-V

ขนาด panel ส�าหรับการติดตั้งบนแผงควบคุม โดยมีขนาดตามที่แสดงด้านล่าง

A

B
C

C

A

BC C

แนวนอน แนวดิ�ง

หน่วย: มม.

รุ่น A B C ความหนาของ panel

GT2712-S
302

(+2, 0)

228

(+2, 0)

10 หรือมากกว่า 1.6 ถึง 4

GT2710-S, GT2710-V
289

(+2, 0)

200

(+2, 0)

GT2708-S, GT2708-V
227

(+2, 0)

176

(+2, 0)

GT2705-V
153

(+2, 0)

121

(+2, 0)

ขนาด C แสดงการวัดส�าหรับการติดตั้งบนแผงควบคุม
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3 ต�าแหน่งการติดตั้ง

การ GOT จ�าเป็นต้องมีระยะห่างระหว่าง GOT และอุปกรณ์อื่นบ้าง

 ● GT27

โดยขึ้นกับยูนิดและสายเคเบิลที่ใช้ส�าหรับ GOT อาจต้องการระยะทางที่มากกว่าที่บรรยายไว้

การติดตั้ง GOT จะต้องพิจารณาถึงขนาดภายในของคอนเนคเตอร์ และรัศมีการโค้งของสายเคเบิล

ส�าหรับระยะทางดึงออกของสายเคเบิลจากด้านล่างไปยัง GOT โปรดดูเอกสารต่อไปนี้

→ GOT2000 Series User’s Manual (Hardware)

ส�าหรับการติดตั้งในแนวดิ่ง จะต้องติดตั้ง GOT โดยให้ลูกศรการติดตั้งในแนวดิ่งที่พิมพ์อยู่ที่ด้านหลังของ GOT ชี้ขึ้นด้านบน

→ GOT2000 Series User’s Manual (Hardware)

B

ED

A

C

ความหนาของ panel: 1.6 ถึง 4

หน่วย: มม.

แนวนอน

B

D

E
A

C

แนวดิ�ง ความหนาของ panel: 1.6 ถึง 4

หน่วย: มม.

ตารางต่อไปนี้แสดงระยะห่างระหว่าง GOT และอุปกรณ์อื่นๆ

ใช้ขนาดภายในวงเล็บเมื่อไม่ได้ติดตั้ง GOT ใกล้กับอุปกรณ์ที่สร้างเสียงรบกวน หรือใกล้กับความร้อน

อย่างไรก็ตามให้รักษาอุณภูมิแวดล้อมของ GOT ไม่ให้เกิน 55°C
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หน่วย: มม.

รายการ
GT27

GT2715-X GT2712-S GT2710-S, GT2710-V GT2708-S, GT2708-V GT2705-V

A

GOT เท่านั้น
48 หรือมากกว่า

[18 หรือมากกว่า]

48 หรือมากกว่า  

[29 หรือมากกว่า]
59 หรือมากกว่า

พอดีกับยูนิตคอนเนคชันบัส
48 หรือมากกว่า

[18 หรือมากกว่า]

23 หรือมากกว่า  

[29 หรือมากกว่า]
48 หรือมากกว่า

พอดีกับยูนิตคอนเนคชันแบบ

อนุกรม

48 หรือมากกว่า

[18 หรือมากกว่า]
47 หรือมากกว่า

พอดีกับยูนิตสื่อสาร CC-Link 

(GT15-J61BT13)

48 หรือมากกว่า

[18 หรือมากกว่า]

50 หรือมากกว่า [22 

หรือมากกว่า]

พอดีกับยูนิตสื่อสาร 

MELSECNET/H (โคแอกเชีย

ล) *1

48 หรือมากกว่า

[18 หรือมากกว่า]

48 หรือมากกว่า  

[38 หรือมากกว่า]

48 หรือมากกว่า  

[45 หรือมากกว่า]
67 หรือมากกว่า 81 หรือมากกว่า

การสื่อสาร MELSECNET/H

พอดีกับยูนิต (ออพติก)*2

48 หรือมากกว่า

[18 หรือมากกว่า]
77 หรือมากกว่า

พอดีกับยูนิตการสื่อสารเครือ

ข่าย CC-Link IE Control

48 หรือมากกว่า

[18 หรือมากกว่า]
55 หรือมากกว่า

พอดีกับยูนิตการสื่อสารเครือ

ข่าย CC-Link IE Field

48 หรือมากกว่า

[18 หรือมากกว่า]
55 หรือมากกว่า

พอดีกับยูนิตอินพุตวิดีโอ*1
48 หรือมากกว่า

[18 หรือมากกว่า]

48 หรือมากกว่า  

[38 หรือมากกว่า]

48 หรือมากกว่า  

[45 หรือมากกว่า]
67 หรือมากกว่า -

พอดีกับยูนิตอินพุต RGB*3
48 หรือมากกว่า

[18 หรือมากกว่า]
-

พอดีกับยูนิตอินพุตวิดีโอ/

RGB*1*3 

48 หรือมากกว่า

[18 หรือมากกว่า]

48 หรือมากกว่า  

[38 หรือมากกว่า]

48 หรือมากกว่า  

[45 หรือมากกว่า]
67 หรือมากกว่า -

พอดีกับยูนิตเอาท์พุต RGB*3
48 หรือมากกว่า

[18 หรือมากกว่า]
-

พอดีกับยูนิตมัลติมีเดีย*1
48 หรือมากกว่า

[18 หรือมากกว่า]

48 หรือมากกว่า  

[38 หรือมากกว่า]

48 หรือมากกว่า  

[45 หรือมากกว่า]
67 หรือมากกว่า -

พอดีกับยูนิตเครื่องพิมพ์
48 หรือมากกว่า

[18 หรือมากกว่า]

พอดีกับยูนิต I/O ภายนอก
48 หรือมากกว่า

[18 หรือมากกว่า]

พอดีกับยูนิตเอาท์พุตเสียง
48 หรือมากกว่า

[18 หรือมากกว่า]

B
แนวนอน: 78 หรือมากกว่า [18 หรือมากกว่า]

แนวตั้ง: 48 หรือมากกว่า [18 หรือมากกว่า]

C

เมื่อใช้เอสดีการ์ด
50 หรือมากกว่า

[20 หรือมากกว่า]
50 หรือมากกว่า 100 หรือมากกว่า

เมื่อไม่ได้ใช้เอสดีการ์ด
50 หรือมากกว่า

[20 หรือมากกว่า]
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หน่วย: มม.

รายการ
GT27

GT2715-X GT2712-S GT2710-S, GT2710-V GT2708-S, GT2708-V GT2705-V

D
แนวนอน: 50 หรือมากกว่า [20 หรือมากกว่า]

แนวตั้ง: 80 หรือมากกว่า [20 หรือมากกว่า]

E*4
100 หรือมากกว่า

[20 หรือมากกว่า]

*1 ค่านี้ส�าหรับการใช้สายเคเบิลโคแอกเชียล 3C-2V (JIS C 3501) 

ส�าหรับคุณลักษณะของสายเคเบิล โปรดดู GOT2000 Series Connection Manual

*2 ค่านี้แตกต่างออกไปโดยขึ้นกับสายเคเบิลที่ใช้

*3 ค่านี้แตกต่างออกไปโดยขึ้นกับสายเคเบิลที่ใช้ 

หากรัศมีการโค้งของสายเคเบิลที่ใช้มากกว่าค่าที่ระบุด้านบน ใช้ค่าของสายเคเบิลที่ใช้

*4 เมื่อท�าการเปิดหรือปิดฝาปิดแบตเตอรี่: 72 หรือมากกว่า
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 ● GT27

ติดตั้ง GOT โดยวางต�าแหน่งส่วนการแสดงผลตามที่แสดงด้านล่าง

การใช้ GOT ด้วยมุมการติดตั้งอื่นนอกจากนี้จะลดอายุการใช้งานของ GOT

เมื่อติดตั้งยูนิตมัลติมีเดีย (GT27-MMR-Z) ยูนิตการสื่อสาร MELSECNET/H (GT15-J71LP23-25, GT15-J71BR13) หรือยูนิตการสื่อสาร CC-Link 

(GT15-J61BT13) แล้ว อุณหภูมิแวดล้อมในการท�างานต้องต�่ากว่าอุณหภูมิสูงสุด 55°C ประมาณ 5°C ตามที่ระบุไว้ในคุณลักษณะทั่วไป

(1) การติดตั้ง GOT ในแนวนอน
เมื่อติดตั้ง GOT ในมุมใดตั้งแต่ 60° จนถึง 105° อุณหภูมิภายในแผงควบคุมต้องอยู่ภายใน 55°C

เมื่อติดตั้ง GOT ในมุมใดๆ ที่อยู่นอกช่วงตั้งแต่ 60° จนถึง 105° อุณหภูมิภายในแผงควบคุมต้องอยู่ภายใน 40°C

GOT

ส่วนการ
แสดงผล

แผงควบคุม 
หรืออื�นๆ

105°

60°

(2) การติดตั้ง GOT ในแนวตั้ง
เมื่อติดตั้ง GOT ที่มุม 90° อุณหภูมิภายในแผงควบคุมต้องอยู่ภายใน 55°C

เมื่อติดตั้ง GOT ในมุมใดๆ ที่ไม่ใช่ 90° อุณหภูมิภายในแผงควบคุมต้องอยู่ภายใน 40°C

GOT

ส่วนการ
แสดงผล

แผงควบคุม 
หรืออื�นๆ

90°

4 อุณหภูมิภายในแผงควบคุมและมุมการติดตั้งของ GOT
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5 การติดตั้ง GOT

 ● GT27

การเปิด panel

GOT
1 ใส่ด้านหลังของ GOT เข้าไปยังช่องเปิดของ panel

 ● ส�าหรับ GT2715-X (8 จุดยึด) 2 ขันสกรูให้แน่นภายในช่วงแรงบิดที่ระบุ (0.36 N·m ถึง 

0.48 N·m)

การขันสกรูด้วยแรงบิดที่เกินช่วงแรงบิดที่ระบุอาจท�าให้แผง

ด้านหน้าของ GOT ผิดรูป

 ● ส�าหรับ GT27 ยกเว้น GT2715 -X (4 จุดยึด)

3 ถอดฟิล์มป้องกันออกจาก GOT
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6 การถอด GOT

 ● GT27

 ● ส�าหรับ GT2715-X (8 จุดยึด)

1 ถอดสกรูออกจาก GOT

ถอดสกรูออกจาก GOT

 ● ส�าหรับ GT27 ยกเว้น GT2715-X (4 จุดยึด)

การเปิดแผง

GOT
2 ถอด GOT ออกจากช่องเปิดของ panel
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7 การใส่/การถอดเอสดีการ์ด

ขั้นตอนส�าหรับการใส่เอสดีการ์ดแสดงไว้ด้านล่าง

 ● GT27

1 เปิดฝาปิดเอสดีการ์ดตามที่แสดงด้านซ้าย

(ด้านหลังของ GOT จะหันไปทางด้านบนตามภาพประกอบ)

เปิดฝาปิดของ
อินเตอร์เฟซเอสดีการ์ด 
90 องศาหรือมากกวา่

LED การเขา้ถึง
เอสดีการ์ด

2 หลังจากตรวจสอบว่าไฟ LED การเข้าถึงของเอสดีการ์ดดับแล้ว 

โดยที่ฝาปิดเอสดีการ์ดเปิด 90 องศาหรือมากกว่า ใส่เอสดีการ์ด

โดยที่หันด้านหน้าลง

3 ดันและปิดฝาปิดเอสดีการ์ดจนกว่าจะได้ยินเสียงคลิก

4 เมื่อฝาปิดเอสดีการ์ดปิดแล้ว จะสามารถเข้าถึงยังเอสดีการ์ดได้
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ขั้นตอนส�าหรับการถอดเอสดีการ์ดแสดงไว้ด้านล่าง

 ● GT27

1 เปิดฝาปิดเอสดีการ์ดตามที่แสดงด้านซ้าย

เปิดฝาปิดของ
อินเตอร์เฟซเอสดีการ์ด
90 องศาหรือมากกวา่

LED การเขา้ถึง
เอสดีการ์ด

2 หลังจากตรวจสอบว่าไฟ LED การเข้าถึงของเอสดีการ์ดดับแล้ว 

โดยที่ฝาปิดเอสดีการ์ดเปิด 90 องศาหรือมากกว่า ดันเอสดีการ์ด

เข้าไปเพื่อถอดออก

3 ปิดฝาปิดของอินเตอร์เฟซเอสดีการ์ด
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8 การจัดเรียงสายไฟจ่ายไฟไปยัง GOT

ต่อไปนี้แสดงตัวอย่างของ การจัดเรียงสายไฟจ่ายไฟ สายเคเบิลกราวด์ และสายเคเบิลอื่นๆ ไปยังเทอร์มินอลของ GOT

 ● GT27

อินพตุ
100-240 V AC

GOT

อินพตุ
24 V DC

ฟิวส์
สาํหรับ 200 V AC

+-

สายเคเบิลกราวด์

กราวด์

สาํหรับ 24 V DC
GOT

+-

อินพตุ
24 V DC

สาํหรับ 24 V DC (GT2705)
GOT

 ~ ข้อควรระวังเบื้องต้น (GT27)

(1) การดูแลสายจ่ายไฟ
ส�าหรับสายเคเบิล 200 V AC และ 24 V DC ใช้สายแบบหนาให้มากที่สุดเท่าที่จะเป็นไปได้ (หน้าตัดของสายเคเบิล: 0.75 ถึง 2 มม.2) และตรวจสอบให้

แน่ใจว่าบิดเกลียวที่ขั้วสายไฟ

เพื่อป้องกันการลัดวงจรเนื่องจากสกรูหลวม ให้ใช้ขั้วสายไฟที่ไม่มีการบัดกรีด้วยปลอกฉนวน

(2) กราวด์
หลังจากการเชื่อมต่อขั้วสายไฟ LG และขั้วสายไฟ FG ตรวจสอบให้แน่ใจว่าได้เชื่อมต่อกับกราวด์แล้ว

มิเช่นนั้นระบบจะอ่อนไหวต่อการรบกวน

ขั้วสายไฟ LG มีศักย์ไฟฟ้าเท่ากับครึ่งหนึ่งของแรงดันไฟฟ้าอินพุต

ดังนั้นการสัมผัสกับขั้วสายไฟอาจน�าไปสู่ไฟฟ้าลัดวงจร

ส�าหรับ GT2705-V ให้เชื่อมต่อกับขั้วสายไฟ FG เท่านั้นเนื่องจากรุ่นนี้ไม่มีขั้วสายไฟ LG

ส�าหรับรายละเอียดของการดูแลรักษาสายเคเบิลจ่ายไฟและสายกราวด์ โปรดดูคู่มือต่อไปนี้

→GOT2000 Series User’s Manual (Hardware)
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ข้อผิดพลาดการสัมผัสหน้าจออาจเกิดขึ้นได้

โดยปกติแล้วไม่จ�าเป็นต้องท�าการปรับ อย่างไรก็ตามความแตกต่างระหว่างต�าแหน่งที่สัมผัสและต�าแหน่งของวัตถุอาจเกิดขึ้นได้เมื่อเวลาผ่านไป

เมื่อมีความแตกต่างระหว่างต�าแหน่งที่สัมผัสและต�าแหน่งของวัตถุเกิดขึ้น ปรับแก้ไขต�าแหน่งด้วยฟังก์ชันนี้

Run Stop Run Stop

ก่อนการปรับ หลงัการปรับ

ตอ้งการสมัผสัปุ่ม [Stop]
แต่ [Run] ทาํงาน

สามารถสมัผสัปุ่ม [Stop] ได้
โดยไม่ลม้เหลว

(1) ขั้นตอนส�าหรับการปรับพิกัดของแผงสัมผัส

1

1 สัมผัส [Utility call key]

2

2 สัมผัส [Touch panel calibration] บนหน้าจอ [Maintenance] 

ใน [Utility main menu]

ภาคผนวก 3 การ calibrate แผงสัมผัส
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3 สัมผัสตรงกลางของ  ที่แสดงด้านบนซ้ายอย่างแม่นย�า

4 สัมผัสจุด  ที่แสดงที่ด้านบนขวา

5 สัมผัสจุด  ที่แสดงที่ด้านล่างซ้าย
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6 สัมผัสจุด  ที่แสดงที่ด้านล่างขวา

7 การสัมผัสปุ่ม  ที่แสดงที่ด้านบนขวาจะกลับไปยังหน้าจอ

ก่อนหน้า

เมื่อไม่สามารถท�าการสัมผัสอย่างแม่นย�าได้ สัมผัสปุ่ม 

[Readjustment] จะท�าการตั้งค่าจาก 3  อีกครั้ง
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ภาคผนวก 4 แคทตาล็อกและคู่มือที่เกี่ยวข้อง

แคทตาล็อกซีรีส์ GOT2000

ชื่อแคทตาล็อก หมายเลขแคทตาล็อก

Graphic Operation Terminal GOT2000 Series L(NA)08270ENG

Graphic Operation Terminal Screen Design Software MELSOFT GT Works3 L(NA)08170ENG

คู่มือที่เกี่ยวข้องของซีรีส์ GOT2000

ชื่อคู่มือ หมายเลขคู่มือ

GOT2000 Series User’s Manual (Hardware) SH-081194ENG

GOT2000 Series User’s Manual (Utility) SH-081195ENG

GOT2000 Series User’s Manual (Monitor) SH-081196ENG

GOT2000 Series Connection Manual (Mitsubishi Products) For GT Works3 Version1 SH-081197ENG

GT Designer3 (GOT2000) Screen Design Manual SH-081220ENG
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ภาคผนวก 5 ชุดประกอบอุปกรณ์ฝึกอบรมการปฏิบัติ

ภาคผนวกนี้บรรยายคุณลักษณะและวิธีการเชื่อมต่อของอุปกรณ์ฝึกอบรมที่ใช้ใน “Satellite Training System Part 3: GOT”

การก�าหนดค่าอุปกรณ์

• เบรกเกอร์: NF30-FA (2 P, 10 A) โดย Mitsubishi Electric Corporation

• PLC: MELSEC iQ-R โดย Mitsubishi Electric Corporation

• Graphic operation terminal: GT2708-STBA โดย Mitsubishi Electric Corporation

• switch หยุดฉุกเฉิน

แผนผังการเชื่อมต่ออุปกรณ์ฝึกอบรมการปฏิบัติ

NF30-FA (Mitsubishi Electric Corporation)

การจ่ายไฟฟ้ากระแสสลบัเฟสเดียว
200 V AC

L N

2 4

1 3

อินพตุ AC

อินพตุ AC

กราวด์

Graphic Operation Terminal 
GT2708-STBA 
(Mitsubishi Electric Corporation)

PLC MELSEC iQ-R 
(Mitsubishi Electric Corporation)

สาย Ethernet

สาย USB

คอมพิวเตอร์ส่วนบุคคล

L1 N1
→

STOP switch 
ฉุกเฉิน

24 V DC 
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ขั้นตอนการเชื่อมต่ออุปกรณ์ฝึกอบรม

1. เดินสายเคเบิลจ่ายไฟ (200 V AC) ที่ด้านหลักของเบรกเกอร์

2. เดินขั้วสายไฟอินพุตจ่ายไฟของ PLC และ GOT ที่ด้านรองของเบรกเกอร์

3. เดินสายไฟ switch หยุดฉุกเฉิน

4. เชื่อมต่อคอมพิวเตอร์ส่วนบุคคลและ GOT ด้วยสาย USB

5. เชื่อมต่อ GOT และ PLC ด้วยสาย Ethernet

ส�าหรับการตั้งค่าการสื่อสารระหว่างคอมพิวเตอร์ส่วนบุคคลและ GOT โปรดดู “2.1.1 การเชื่อมต่อคอมพิวเตอร์ส่วนบุคคลกับ GOT” ในข้อความนี้

ส�าหรับการตั้งค่าการสื่อสารระหว่าง GOT และ PLC โปรดดู “2.2.1 การเชื่อมต่อ GOT และ PLC” ในข้อความนี้



เครื่องหมายการค้าและเครื่องหมายการค้าจดทะเบียน

ชื่อของผลิตภัณฑ์และบริษัทเป็นเครื่องหมายการค้าหรือเครื่องหมายการค้าจดทะเบียนของเจ้าของที่เกี่ยวข้อง

สีจริงอาจแตกต่างจากภาพในแคทตาล็อกนี้เล็กน้อย

สีจริงอาจแตกต่างจากภาพที่แสดงบนหน้าจอ GOT





Your First GOT
Satellite Training Series PART 3

GOT แรกของคุณ

Graphic Operation Terminal

HEAD OFFICE: TOKYO BUILDING, 2-7-3, MARUNOUCHI, CHIYODA-KU, TOKYO 100-8310, JAPAN
NAGOYA WORKS: 1-14, YADA-MINAMI 5-CHOME, HIGASHI-KU, NAGOYA, JAPAN 

มถินุายน 2560KK016-T1706A-TH H-1706(MEE) อาจมกีารเปล ีย่นเน ือ้หาโดยไมม่ กีารแจ้งใหท้ราบลว่งหน้า
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